
 

e-terraMarket ENTSO-E – eCAT - Capacity Auction May 2023 

 

 
 
 
 
 
 
 
 
 

E-terraMarket 
 

ENTSO-E Capacity Auction 
 

  Electronic Capacity Allocation Tool – eCAT 

JAO Participant User’s Guide 

Product Release May 2023 

 



 

e-terraMarket ENTSO-E – eCAT - Capacity Auction May 2023 

 

Copyright © 2023 GE.  All Rights Reserved. 

GE proprietary information.  
 

 

 

 

 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

JAO-eCAT_e-terramarket ENTSO-E Capacity Auction - Participant User Guide_May2023_r_V3.doc  iii 

Contents 

1. About This Guide........................................................................................................... 6 

1.1 WHAT THIS GUIDE COVERS ..................................................................................................................... 6 
1.2 WHO SHOULD READ THIS GUIDE ............................................................................................................. 6 
1.3 HOW THIS GUIDE IS ORGANIZED .............................................................................................................. 6 
1.4 CONVENTIONS ......................................................................................................................................... 7 

2. Introduction to e-terraMarket ENTSO-E Capacity Auction ...................................... 9 

2.1 SYSTEM OVERVIEW ................................................................................................................................. 9 
2.2 WHAT USERS SHOULD KNOW ................................................................................................................ 10 

2.2.1 Terms & Concepts ......................................................................................................................... 10 
2.2.2 About Inputs................................................................................................................................... 11 
2.2.3 About Data outputs ........................................................................................................................ 11 
2.2.4 About Capacity Auction ................................................................................................................. 12 

3. System Features .......................................................................................................... 15 

3.1 A LOOK AT THE GUI .............................................................................................................................. 15 
3.1.1 Main Screen................................................................................................................................... 15 

3.2 SCREEN LAYOUT ................................................................................................................................... 15 
3.3 MENU HIERARCHY ................................................................................................................................. 16 
3.4 NAVIGATING WITH THE GUI .................................................................................................................... 18 

3.4.1 Logging In and Out ........................................................................................................................ 18 
3.4.2 Controlling Frames, Tabs, Menus, and Calendars........................................................................ 19 

3.4.2.1 Frames ..................................................................................................................................... 19 
3.4.2.2 Tabs ......................................................................................................................................... 20 
3.4.2.3 Drop-down Menus .................................................................................................................... 20 
3.4.2.4 Pull-Down Menus ..................................................................................................................... 21 
3.4.2.5 Calendar Controls .................................................................................................................... 21 

3.4.3 Working with Display Records and Other Text-Labeled Items ..................................................... 22 
3.4.4 Filter & Sort Displays ..................................................................................................................... 23 

3.4.4.1 Sort Rows ................................................................................................................................. 23 
3.4.4.2 Filter Rows ............................................................................................................................... 23 

3.4.5 Changing the Password ................................................................................................................ 24 
3.4.6 Limited user access to predefined borders ................................................................................... 25 

4. Participant Tasks ......................................................................................................... 27 

4.1 ENTITLEMENTS ...................................................................................................................................... 29 
4.2 FILE MANAGEMENT................................................................................................................................ 30 

4.2.1 File Upload ..................................................................................................................................... 31 
4.2.2 File Download ................................................................................................................................ 32 

4.3 AUCTION MANAGEMENT......................................................................................................................... 37 
4.3.1 Auction identification ...................................................................................................................... 41 
4.3.2 Auction Parameters ....................................................................................................................... 42 
4.3.3 Bidding  Parameters ...................................................................................................................... 43 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

JAO-eCAT_e-terramarket ENTSO-E Capacity Auction - Participant User Guide_May2023_r_V3.doc  iv 

4.3.4 Auction Gates ................................................................................................................................ 44 
4.3.5 Products ......................................................................................................................................... 45 
4.3.6 Allocation Constraints .................................................................................................................... 46 
4.3.7 Auction Results .............................................................................................................................. 47 
4.3.1 Maintenance Periods ..................................................................................................................... 48 
4.3.2 Comments ..................................................................................................................................... 48 

4.4 BID MANAGEMENT ................................................................................................................................. 49 
4.4.1 Bid states ....................................................................................................................................... 49 
4.4.2 Bid Submission checks .................................................................................................................. 51 
4.4.3 Credit Limit checking ..................................................................................................................... 52 
4.4.4 New Bid Creation through UI ......................................................................................................... 53 
4.4.5 New Bid creation through File Upload ........................................................................................... 59 
4.4.6 Copy/paste from Excel .................................................................................................................. 59 
4.4.7 View bid screen ............................................................................................................................. 60 
4.4.8 Bid List ........................................................................................................................................... 63 

4.4.8.1 Bid identification ....................................................................................................................... 65 
4.4.8.2 Bid blocks ................................................................................................................................. 66 
4.4.8.3 Bid Parameters ........................................................................................................................ 67 

4.4.9 Bid Modification ............................................................................................................................. 67 
4.4.10 Bid Cancellation ........................................................................................................................... 68 

4.5 Default bids ......................................................................................................................................... 70 
4.5.1 Default Bid submission checks ...................................................................................................... 70 
4.5.2 Default Bids exceeding OC ........................................................................................................... 71 
4.5.3 New default Bid Creation ............................................................................................................... 71 
4.5.4 Copy/paste from Excel .................................................................................................................. 74 
4.5.5 Default Bid Modification ................................................................................................................. 74 
4.5.6 Default Bid Cancellation ................................................................................................................ 75 
4.5.7 Surrogate Default bidding .............................................................................................................. 76 

4.6 SHADOW AUCTIONS ............................................................................................................................... 76 
4.6.1 Business process overview ........................................................................................................... 77 

4.7 ALLOCATION RESULT ............................................................................................................................. 77 
4.7.1 Allocation Result Control ............................................................................................................... 79 

4.8 SECONDARY MARKET ............................................................................................................................ 84 
4.8.1 Transfer of capacity rights ............................................................................................................. 84 

4.8.1.1 Transfer Notification submission rules ..................................................................................... 85 
4.8.1.2 New Transfer Notification through GUI .................................................................................... 85 
4.8.1.3 New transfer notification through File Upload .......................................................................... 87 
4.8.1.4 Transfer notification control...................................................................................................... 88 

4.8.2 Balancing service for capacity rights ............................................................................................. 89 
4.8.2.1 Balancing reservation submission rules .................................................................................. 90 
4.8.2.2 Balancing reservation through GUI .......................................................................................... 91 
4.8.2.3 Balancing reservation through File Upload .............................................................................. 93 
4.8.2.4 Balancing reservation control................................................................................................... 93 

4.8.3 Resale of capacity rights ............................................................................................................... 95 
4.8.3.1 Resale Notification submission rules ....................................................................................... 96 
4.8.3.2 New Resale Notification through GUI ...................................................................................... 97 
4.8.3.3 New resale notification through File Upload ............................................................................ 98 
4.8.3.4 Resale notification control ........................................................................................................ 98 

4.9 CAPACITY RIGHT PORTFOLIO MANAGEMENT ........................................................................................ 101 
4.9.1 Review details of capacity right portfolio ..................................................................................... 101 

4.10 ITR DESIGNATION ............................................................................................................................. 103 
4.10.1 New ITR Designation through GUI ............................................................................................ 104 

4.11 PROGRAMMING AUTHORIZATION MANAGEMENT.................................................................................. 105 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

JAO-eCAT_e-terramarket ENTSO-E Capacity Auction - Participant User Guide_May2023_r_V3.doc  v 

4.12 Settlement ....................................................................................................................................... 107 
4.12.1 Display invoices screen ............................................................................................................. 107 
4.12.2 Updating status of invoice ......................................................................................................... 109 

5. Online Help .................................................................................................................110 

Glossary ..........................................................................................................................112 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

JAO-eCAT_e-terramarket ENTSO-E Capacity Auction - Participant User Guide_May2023_r_V3.doc  6 

1. About This Guide 

1.1 WHAT THIS GUIDE COVERS 

Welcome to the e-terraMarket ENTSO-E Capacity Auction User’s Guide. This 
guide explains how to use the e-terraMarket ENTSO-E Capacity Auction’s GUI to 
perform the participant tasks to buy transmission capacity on boundaries between 
cross-border countries.   

 

1.2 WHO SHOULD READ THIS GUIDE 

This guide is primarily intended for: 

• Registered Participants  

o Capacity Trader: Acquires capacity on the capacity market through the 
Transmission Capacity Allocator (TCA). The capacity in question may be 
acquired on behalf of an Interconnection Trade Responsible or acquired 
to be sold on the secondary market. 

o System Operator: The role of the System Operator in a wholesale 
electricity market is to manage the security of the power system in real 
time and co-ordinate the supply of and demand for electricity, in a 
manner that avoids fluctuations in frequency or interruptions of supply. 

This guide assumes familiarity with the concepts of capacity auction. Users should 
also be familiar with basic computer concepts related to browsers, windows, 
menus, and mouse. 

 

1.3 HOW THIS GUIDE IS ORGANIZED 

This guide includes the following chapters: 

• About This Guide: This chapter describes what this guide covers, who should 
read it, how it’s organized, and the conventions it uses.  

• Introduction to e-terraMarket ENTSO-E Capacity Auction: Provides an 
overview of the system, its components and what it does. Explains terms and 
concepts users need to know when working with the system. 

• System Features: Presents the GUI screens and features. Explains basic GUI 
tasks, such as logging in and menu navigation. 
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• Participant Tasks: Explains how to perform the individual tasks to deal with 
transmission capacity. They include: 

1. Auction process, to explain how the Allocation Platform will run the explicit 
capacity auction. 

2. Bidding, to explain how to make and change bids using the tool. 

3. Auction results, to help the user to interpret the auction final results. 

4. Secondary Market, to explain how to declare transfer and resale 
notifications. 

5. Management of Capacity Right Portfolios, to follow the update of capacity 
rights after auction allocation, auction cancellation, secondary market and 
capacity curtailment. 

6. ITR Designation, to explain how to change ITR designation on a long-term 
auction. 

7. Management of Programming Authorizations, to be used by participants in 
the nomination process. 

 

1.4 CONVENTIONS 

The following formatting conventions are used in this document. 

 

Table 1 Formatting Conventions 

Convention Example Explanation 

>  Go to Enterprise > Parameters Indicates the selection path to a menu 
option. 

  To log in:  Indicates one of multiple procedures, 
which are given within the same chapter 
section. 

 

The following abbreviations are used by the e-terraMarket ENTSO-E Capacity Auction 
system and this document. 

 

Table 2 Abbreviations 

Abbreviation Explanation 

ATC Available Transmission Capacity 

AAC Already Allocated Capacity 
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Abbreviation Explanation 

CT Capacity Trader 

ITR Interconnection Trade Responsible 

LT Long Term (yearly, seasonally, quarterly, or monthly) 

LTC Long Term Contract 

NTC Net Transfer Capacity 

OC Offered Capacity 

SO System Operator 

TCA Transmission Capacity Allocator 

TTC Total Transfer Capacity 
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2. Introduction to e-terraMarket ENTSO-E Capacity Auction 

2.1 SYSTEM OVERVIEW 

 

“Capacity auction” module of e-terramarket platform developed by GE supports the full 
process from the identification and publication of offered capacity to the publication of 
allocation results. The allocation of capacity rights is supported by a market based 
matching process taking as input capacity bids submitted by market participants. 

The proposed solution enables to manage explicit auctions on several borders.  

 

The following sections discuss the operational processes of the market participant’s 
web interface in details. They explain various terms and concepts used within the 
context of the e-terraMarket ENTSO-E Capacity Auction system. 
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2.2 WHAT USERS SHOULD KNOW 

2.2.1 Terms & Concepts 

Other e-terraMarket ENTSO-E Capacity Auction terms and concepts you should be 
familiar with are as follows: 

• TCA: They are responsible for the organization and the allocation of the auctions. 
They operate the capacity auctioning system and organize the auctions. 

• Market Participant: 

o ITR: Interconnection Trade Responsible. They are Balance 
Responsible Party (BRP) or depend on one BRP. They are recognized 
by the Nomination Validator for the nomination of allocated capacity. 

 

o Capacity Trader Acquires capacity on the capacity market through the 
TCA. The capacity in question may be acquired on behalf of an 
Interconnection Trade Responsible or acquired to be sold on the 
secondary market. They can view the public information for the market 
participants and their own bids and rights (submitted bids and allocated 
transmission capacity rights), they can maintain, upload, download 
them 

• TSO: Transmission system operator. They are responsible for determining 
available capacity on the borders (ATC). They can view the public information for 
the market participants. 

• Gate: It is a period during which some actions can be done with the system. A 
gate opens and closes at pre-defined times. In the Capacity Auction System, 
some processes are triggered at the opening or the closure of auction gates 
(auction publication, auction clearing, auction results processing). 

• Products: A product can be defined as a block composed of 1 or more-time 
intervals which are not necessarily contiguous, but with a constant value (a 
product doesn’t define a volume, it defines a profile). The different blocks can be 
attached to separate auctions or to the same auction.  Each block is cleared 
separately. 
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2.2.2 About Inputs 

Inputs from participants to e-terraMarket ENTSO-E Capacity Auction include: 

• Capacity Bids that can be manually uploaded as ECAN  Bid Document file  
v4r0 via the menu File > Upload or entered on the GUI. 

• Resale Notifications that can be manually uploaded as ECAN Rights 
Document file v4r0 via the menu File > Upload or entered on the GUI. 

• Default Bids that can be manually entered through the GUI. 

• Transfer Notifications that can be manually uploaded as ECAN Rights 
Document file v4r0 (or entered on the GUI). 

• Balancing reservation that can be manually uploaded as ECAN Rights 
Document file v4r0 (or entered on the GUI). 

 

2.2.3 About Data outputs 

Data outputs to participants from e-terraMarket ENTSO-E Capacity Auction 
include: 

• Confirmation of registration in the System  received via email by the 
participants. 

• Auction characteristics, displayed in the GUI and published on JAO’s website 

• Bid  and resale Acknowledgment Document (ENTSO-E ACK document) 
received via email by the participants  and downloadable through the GUI by 
the participants. 

• Allocation result document (ECAN Allocation Result document v4r0) 
downloadable through the GUI by the participants. 

• Capacity Right Portfolio Document (ECAN Rights Document file v4r0) 
downloadable through the GUI by the participants  

• Transfer confirmation as ECAN Rights Document file v4r0 received via email 
by the participants  and downloadable through the GUI by the participants 

• Long-Term Programming Authorizations as ECAN Rights Document file v4r0 
received via email by the participants  and downloadable through the GUI by 
the participants  

• Daily Programming Authorizations as ECAN Rights Document file v4r0 
received via email by the participants  and downloadable through the GUI by 
the participants  

• Day ahead Min/Max AAC as ECAN Rights Document file v4r0 received via 
email by the participants  and downloadable through the GUI by the 
participants  

• Settlement results as Excel document downloadable through the GUI by the 
participants  
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2.2.4 About Capacity Auction 

NOTE 

For more information, please refer to the Glossary. 

Capacity Auction overall process is organized in the following phases: 

• Basic registration: JAO registers the Registered Participant and its individual 
Users in the system.  

• Auction definition: Auctions are created using parameters according to the 
border, direction and horizon. 

• Auction publication: Auction specification is published to the market 
participants. This publication is triggered at ‘Auction creation’ gate closure.  

• ATC submission: ATC is submitted by TSOs to the e-terra market ENTSO-E 
Capacity Auction. 

• ATC publication: At closure of “ATC publication” gate, the ATC is published on 
JAO’s website and ENTSO-E Transparency Platform in the form of an ECAN 
Capacity document v4r0. If a TSO submits an ATC document after “ATC 
publication” gate closure, then a new version of ATC document is published 
on JAO’s website and ENTSO-E Transparency Platform; 

• LT Resale: At closure of “LT Resale” gate, a first version of OC is published 
on JAO’s website and ENTSO-E Transparency Platform in the form of an 
ECAN Capacity document v4r0. If a TSO submits an ATC document after “LT 
resale” gate closure, then a new version of OC document is published on 
JAO’s website and ENTSO-e Transparency Platform. 

• Bidding: Market participants submit bids to the auction to request transmission 
capacity. Bids can be submitted during ‘Pre-Bidding’ gate and ‘Bid 

submission’ gate that have been configured and scheduled for the related 
auction. 

• Clearing: Auction results are processed by applying auction algorithm. This 
matching process is triggered at the opening of the Auction evaluation gate. 

• Allocation result publication: Detailed allocation results are published to the 
capacity traders. This publication is triggered at the closure of the Auction 
evaluation gate.  

• Dispute: Outside of the capacity auction system, Participants may contest the 
auction results during the Dispute submission gate. This may lead JAO to 
cancel the auction. 
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Gate Auction Status Actions on gate opening Actions on gate closure 

Auction creation Created 

Automatic instantiation of 
the auction from auction 

template (market 
configuration) 

Publication of auction to 
market participant UI 

Publication of auction 
specification (without 

offered capacity) on JAO’s 
website 

ATC submission Published then Pre-Open  

Final ATC is sent before 
closure of this gate 

Auction specification can 
be updated no later than 

closure of this gate 

ATC publication Published  
Publication of offered 

capacity on JAO’s website, 
ENTSO-E Transparency 

Platform and TSOs 

LT Resale Published  

Publication of offered 
capacity and Auction 

specification on JAO’s 
website, ENTSO-E 

Transparency Platform and 
TSOs 

Default Bidding Published  

Transformation of default 
bids into pre-bids if pre-

bidding gate exists or into 
bids otherwise. 

Pre-bidding Pre-Open 
Pre-Bid submission from Market Participant during this 

gate 

Bid submission Open Bid submission from Market Participant during this gate 

Auction 
evaluation 

Closed Processing auction results 

Sending of provisional 
auction results to market 

participants and TSOs 

Publication of provisional 
auction results on JAO’s 

website and ENTSO-E Vista 

Dispute 
Submission Published Results 

Participants must submit their contestations (if any) 
before closure of this gate 

Dispute 
Processing Published Results   
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3. System Features 

3.1 A LOOK AT THE GUI 

E-terraMarket ENTSO-E Capacity Auction is accessed through a web-based GUI. 
The following figure shows the Main screen. This screen is the GUI’s primary 
access point to the system features and functions. 

 

 
Figure 1 Main screen 

 

3.1.1 Main Screen 

From the main screen, as from any other screen, all E-terraMarket ENTSO-E 
Capacity Auction Participant screens can be reached. These screens present 
the major features and functions to buy capacity, transfer or resell capacity, 
review capacity right portfolios and programming authorizations. 

• The menus offer features for performing standard functions such as auction 
review. Placing the cursor on a menu title causes the menu to drop down. 

3.2 SCREEN LAYOUT 

The e-terraMarket ENTSO-E Capacity Auction screens share a common layout, 
with: 

• Filtering criteria pane: the topmost area offers a set of filters that can be used 
to search auctions, bids, events or allocation results, depending on the screen 
currently displayed.  

• List pane: In the center, the search result is displayed as a list of items.  

Each row provides some summary information on an auction, a bid, a file or an 
event. The list may also display a few action icons for each row, providing a 
quick way to open or download a file, or to create, modify or cancel a bid.  
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• Details pane: The bottom part of the screen shows all the details about the item 
currently selected from the list. For an auction, that would be its identification 
details, the product and the capacity offered or gates.  
All this information is organized in multiple tabs. 

 

 

Figure 2 : GUI Screen Layout 

3.3 MENU HIERARCHY 

The Main screen gives access to the various displays of the application through 
the menu bar, at the top of the screen, by clicking on a menu or a submenu item.  

Every stage in the lifecycle of an auction has one or more screens dedicated to it:  

• Once an auction has been published, it can be reviewed in the Auction display 
through Auction menu. 

• Participants can submit and review Bids through New/Edit Bids submenu in Bid 
menu. 

• Participants can display the different versions of Bids in read-only mode through 
Bids submenu in Bid menu 

• Participants can submit and review Default Bids through New/Edit Default Bids 
submenu in Bid menu. 

Filtering 

criteria 

pane 

 

List pane 

 

Details 

pane 
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• All documents either produced by or submitted to the ECAT system are available 
from a single screen through Download submenu in File menu. 

• As soon as an auction has finished, the eCAT system computes and publishes 
the allocation results through Allocation result submenu in the Capacity right 
menu. 

• The details of Capacity Right portfolios can be seen through the Capacity right 
list submenu in the Capacity right menu. 

• All secondary market operations can be performed and checked through 
Secondary market menu. 

• The details of Programming Authorizations can be seen through the 
Programming authorizations submenu in the Programming Authorizations 
menu. 

• The modification of the designated ITR could be made through the New ITR 
designation submenu in the Programming authorizations menu 

• The settlements can be exported through the Settlement menu 

In addition, the Options menu allows users to change their password, the display 
time zone. 

 

The following diagram shows the Main Unit screen’s menus and the options 
available from them.  

 

Figure 3 Drop-Down Menus 

 Placing the cursor on a menu title causes the menu to drop down.  
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Figure 4 Menus  

3.4 NAVIGATING WITH THE GUI  

3.4.1 Logging In and Out 

 To log in to the e-terraMarket ENTSO-E Capacity Auction GUI 

1. Open a new browser window. 

2. Go the Start Session page of eCat located on JAO website. 

3. Select your personal electronic certificate to use.  

4. At the Login page, enter your User ID and Password in the appropriate fields. 
Note that the login fields are case sensitive. 

5. Select the Time Zone  

6. Click the Log in button and the Applications opens. 
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Figure 5 Login Page 

 To log out from the e-terraMarket ENTSO-E Capacity Auction GUI:  

• Select the Logout option from the Options menu.  

This terminates your session and brings you to the Login Page. 

 

3.4.2 Controlling Frames, Tabs, Menus, and Calendars  

3.4.2.1 Frames 

To show and hide a frame: 

• Click on the Show/Hide control in the upper left corner of the frame. 
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Figure 6 Hiding Frames 
 

 

 

 

3.4.2.2 Tabs 

 To select a tab: 

• Click on tab name. The selected tab will be displayed 

 

Figure 7 Selecting tab 

 

3.4.2.3 Drop-down Menus  

 To expand a drop-down menu: 

• Place the cursor over the menu name. Note that it is not necessary to 
click on the menu name to open the menu. 
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 To close a drop-down menu: 

• Move the cursor away from the menu name. 

 

 
Figure 8 Drop-down menus 

 

3.4.2.4 Pull-Down Menus  

 To open pull-down menus: 

• Click on the arrow. 

 To select a menu item: 

• Click on the item, it will be selected automatically. 

 
Figure 9 Pull-down menus 

 

 To dismiss pull-down menus: 

• Click outside local frame area. 

 

3.4.2.5 Calendar Controls  

 To launch the pop-up calendar for date selection, Click the calendar icon. 

 To select a date, do one of the following: 
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• Launch the pop-up calendar, click the scroll arrows to pick a month 
and year, and then select a date. 

• Or enter a date in the date field. 

 To dismiss pop-up calendars: 

• Click outside local frame area. 

 

Figure 10 Calendar Popup 
 

 

3.4.3 Working with Display Records and Other Text-Labeled Items  

 To select a display record and other text-labeled items: 

• Click on the text. For example, to select a data row on a screen, place the cursor 
over the row text and click the left mouse button.  

 

Figure 11 Clicked on Text to Select Screen Items 
 

If more than 12 items need to be displayed, the list is paginated. You can browse 
through the pages using the navigation buttons at the bottom of the list.  
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 To display the other records: 

• Click on the arrows on the bottom of the list. 

o < and > arrows allow going to respectively previous and next screen. 

o << and >> arrows allow going to respectively previous and next ten screens. 

o |< and >| arrows allow going to respectively the first and last page. 

3.4.4 Filter & Sort Displays 

3.4.4.1 Sort Rows 

To sort display records by ascending or descending order: 

• Sort order of rows by clicking on screw, where they appear, in display column 
heading cells. 

 

 

 

 Figure 12 Sorting Criteria Rows 

 

• Select the sorting criteria. The buttons right & Left allow choosing the columns 
on which the criteria is based here Corridor, Bid time left, Market period (or 
Delivery period) start and horizon. The Up & Down buttons allow to specify 
the order by  between the columns.  

3.4.4.2 Filter Rows 

 

To filter display records: 

• In Filtering criteria frame, select the various criteria by clicking on one item or 
none in the different lists. 
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• Click on the Refresh button in the top left corner. 

 

 

Figure 13 Filter Rows & Refresh 
 
 

3.4.5 Changing the Password 

• Go to Options > Password change 

• Enter the old password 

• Enter a new password 

• Re-enter the new password to confirm it. 

• Click the Change button. 

 
Figure 14 Password Change Dialog 

 
Password policy: 

• The password has a minimum of 9 characters 

• The new password must be different to the last [24] passwords used 
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• Password must not contain the user's entire samAccountName (Account 

Name) value or entire displayName (Full Name) value. Both checks are not 

case sensitive:  

o The samAccountName is checked in its entirety only to determine 

whether it is part of the password. If the samAccountName is less 

than three characters long, this check is skipped.  

o The displayName is parsed for delimiters: commas, periods, dashes 

or hyphens, underscores, spaces, pound signs, and tabs. If any of 

these delimiters are found, the displayName is split and all parsed 

sections (tokens) are confirmed not to be included in the password. 

Tokens that are less than three characters in length are ignored, and 

substrings of the tokens are not checked. For example, the name 

"Erin M. Hagens" is split into three tokens: "Erin," "M," and "Hagens." 

Because the second token is only one character long, it is ignored. 

Therefore, this user could not have a password that included either 

"erin" or "hagens" as a substring anywhere in the password.  

• Password must contain characters from at least three of the following five 

categories: 

o Uppercase characters of European languages (A through Z, with 

diacritic marks, Greek and Cyrillic characters) 

o Lowercase characters of European languages (a through z, sharp-s, 

with diacritic marks, Greek and Cyrillic characters) 

o Base 10 digits (0 through 9) 

o Nonalphanumeric characters: ~!@#$%^&*_-+=`|\(){}[]:;"'<>,.?/ 

o Any Unicode character that is categorized as an alphabetic character 

but is not uppercase or lowercase. This includes Unicode characters 

from European languages. 

 

 

3.4.6 Limited user access to predefined borders 

Users can be limited to certain borders. 

These settings are done by the Operators and can be modified depending on the 
necessities of the user. 

By limiting the borders that the users have access to, there are limitations also on 
the actions that the user can do. For example, if a user is limited to certain borders, 

mailto:~!@#$%^&*_-+=`|/(){}[]:;"'<>,.?/
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they will only be able to place bids and view data for the borders that they are 
entitled to. 
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4. Participant Tasks  

 

E-terraMarket ENTSO-E Capacity Auction software provides market participants 
with a set of web pages for direct entry and file upload of bids. 

When data are directly entered through the web page, the system carries out all 
necessary data validation and explicit error messages are sent back to the user in 
case of data rejection. 

When data are sent by a market participant through an XML file transfer, then an 
ENTSO-E acknowledgement document is sent back to the sender. 

The web interface of the E-terraMarket ENTSO-E Capacity Auction product offers a 
set of functionalities to the Market participants allowing them to interact with the 
capacity auction process: 

• View the participant’s entitlements by corridors and horizons 

• View auction specifications (Auction parameters, products, gates, 
maintenance periods) 

• Submit and review default bids 

• Submit and review capacity bids 

✓ Submit bids through the interactive user interface 

✓ Import bids as an XML file using an ENTSO-E Bid document compliant 
with ECAN version 4 format  

• View allocation results (awarded bids)  

✓ Display allocation results through the interactive user interface 

✓ Export allocation results by displaying or downloading the allocation 
results through an XML file. This XML file is an ENTSO-E Allocation 
Result document compliant with ECAN version 4 format 

✓ Export allocation results to a CSV file 

• Declare and review secondary market notifications 

✓ Declare transfer notifications through the interactive user interface 

✓ Import transfer notification XML file using an ECAN Rights document v4r0 

✓ Confirm transfer notifications through the interactive user interface (Italian 
borders only) 

✓ Declare balancing reservation notifications through the interactive user 
interface 
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✓ Import balancing reservation notification XML file using an ECAN Rights 
document v4r0 

✓ Display a list of approved transfers 

✓ Declare resale notifications through the interactive user interface 

✓ Import resale notification XML file using an ECAN Rights document v4r0 

✓ Display a list of confirmed resales 

• View Capacity right portfolios 

• Declare a change on ITR designation for a given auction 

✓ Declare a change on ITR designation using the New ITR designation 
screen 

• View the details of Programming Authorizations 

• Download files 
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4.1 ENTITLEMENTS 

The entitlements of e-terraMarket ENTSO-E Capacity Auction lets participants know 
on which auctions they could participate. 
 
The participants could read their entitlements from the UI menu: Entitlements -> 
Display. 
 
The table display the information below: 

• Corridor code: Unique code to identify the corridors and the direction (i.e.: 
FR-BE is an auction from France to Belgium) 

• Horizon name: Horizon of the auction (e.g. Yearly, Monthly, Daily, Intraday, 
Shadow) 

• Is entitled?: Checkbox to identify the entitlements  

• Effective day: The effective day to participate on the auction 

• Termination day: The termination day to participate on the auction 
 
 

 
Figure 15 Entitlements screen 
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The participants could filter the entitlements by horizon: 

 

Figure 16 Entitlements filtering by horizon 

 

4.2 FILE MANAGEMENT 

 
The file management of e-terraMarket ENTSO-E Capacity Auction lets participants 
manage many various files including bid files, secondary market notification 
documents. 

The capacity auction process relies on the reception and the transmission of several 
files. Participants can upload and download some of them. 

The list is displayed below:  

Tag Sender Receiver Format Document 

Bid for capacity CT JAO ECAN Bid Document 

Auction results (CT)  JAO CT ECAN Allocation results 

Transfer Notification  CT JAO ECAN Rights document 

Approved Transfer (CT) JAO CT ECAN Rights document 

Return Notification CT JAO ECAN Rights document 

Capacity Right Portfolio (CT)  JAO CT ECAN Rights document 

Programming Authorizations (CT)  JAO CT ECAN Rights document 

Day-ahead MIN AAC JAO CT ECAN Rights document 

Day-ahead MAX AAC JAO CT ECAN Rights document 

Balancing reservation Notification  CT JAO ECAN Rights document 

Figure 17 Capacity auction files 
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4.2.1 File Upload 

 To upload a file (such as a Bid File): 

• Go to the menu File > Upload. 

 
Figure 18 File upload screen 

 

• Click on the Browse button  

• An Open pop-up allows the selection of the file to be uploaded 

• The name of the selected file appears in the field. 

• Click on the Upload button 

• The log table displays information about the finished upload and its status. 

o Logging time: Date of log process 

o Message: Log message about upload 

o Status: Message Fully Accepted / Message Fully Accepted under 
reserve / Message Fully Rejected 

o Market Period Start/Stop: target period of the auction 

o Ack.: Acknowledgement of the imported file 
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4.2.2 File Download 

The File download screen provides access to all documents available in the 
capacity auction system to which participants have legitimate rights: their bids, the 
allocation results, their secondary market notifications, their capacity right 
portfolios and the related acknowledgement files when applies. 

To display information about downloadable files: 

• Go to File > Download 

Figure 19 File Download screen 

 

 To filter the data in the Download screen: 

• In Filtering Criteria frame. 

o Select the Document Type 

o Select Domain 

o Select Status 

o Select Horizon 

o Select Start Date and Stop Date 
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▪ If Registration time is checked it will be the dates of a period that 
intersects with the day the searched files were submitted or 
generated 

▪ If Market period is checked, it will be the dates of a period that 
intersects with the Market period of the searched files 

• Click on the Refresh button in the top left corner of the Filtering criteria frame. 
 

 

 

Figure 20 File Download screen after filtering 

 

Download screen fields table: 

Document 
Report / Field 
Name 

Description 

Registration time Date of reception of the file by the capacity auction system 

Domain Domain belonging to the file 

Market period 
Start 

Start delivery date 

Market period 
Stop 

Stop delivery date 
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Horizon Time horizon 

Identification Identification of the document 

Version Version of the document 

Document Type Document Type (Bid => Bid document) 

Status Document Status after upload  

Related 
document 
identification 

Identification of the acknowledgement file generated by the capacity 
auction system to external users (participants). 

Related 
document 
version 

Acknowledgment version  

User Sender user of the document 

Action  Folder icon ( ): open the submitted document in an XML viewer 

Floppy icon ( ): save a copy of the submitted document in its original 
format 

Acknowledgment  Folder icon: open the generated acknowledgement file or statement or 
notice in an XML viewer 

Floppy icon: save of the generated acknowledgement file or statement or 
notice in its original format 

 

 To view the document in the Download screen: 

• Click on Folder icon ( ) in Action 

• The document is displayed through a Document viewer 
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Figure 21 Action: open a file through the file viewer 

 

 To save the document in its original format, in the Download screen: 

• Click on Floppy icon ( ) in Action 

• A File download pop-up opens 

  

Figure 22 Action: open/save a file in its original format 

 

 To view the contents of the acknowledgement file in the Download screen: 

• Click on Folder icon ( ) in column Acknowledgement 

• The document is displayed through a Document viewer 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

Proprietary – See Copyright Page      36 

 
Figure 23 Acknowledgment / Action: open an acknowledgement file through the viewer 

 

 To open/save acknowledgement in its original format from the Download 

screen: 

• Click on Floppy icon ( ) in column Acknowledgement  

• A File download pop-up opens 
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4.3 AUCTION MANAGEMENT 

 
Auction creation gate process:   
 

• At the closure of the ‘Auction creation’ gate, the Auction Specification 
becomes public. 

• The auction status is changed to ‘Published’. 

• Market Participants can view the auctions through the Participant UI. 
 
ATC submission and ATC publication gates process:   
 

• During the ‘ATC submission’ gate, TSOs should submit the declaration of 
ATC. 

• At the closure of the ‘ATC publication’ gate, the ATC is published on JAO’s 
website and ENTSO-E Transparency Platform. 

• If a LT Resale gate exists, Offered capacity is published first at the LT resale 
gate closure on JAO’s website and ENTSO-E Transparency Platform, and at 
every change of capacity between the LT resale gate and ATC submission 
gate closure. 

 
 
In e-terraMarket ENTSO-E Capacity Auction, the life cycle of an auction is controlled by 
a set of states as described in the UML activity diagram below: 

 

 
Figure 24 Auction lifecycle diagram  

 

 

 
 
The auction states are described below: 
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State name Description 

Published The auction becomes public, and market participants can view the 
auction. 
System operators can no longer modify the attributes of the auction. 

Pre-Open An auction is in ‘Pre-Open’ state during the ‘Pre-Bidding’ gate 

Open An auction is in ‘Open’ state as soon as ‘Bid submission’ gate opens 
and while ‘Bid submission’ gate is not closed. 

Closed An auction is in ‘Closed’ state as soon as ‘Bid submission’ gate 
closes and while auction results are not published. 

Published 
results 

The provisional auction results become public; they must be 
available in the participant interface. Results become final by 
expiration of contestation period. 

Cancelled An auction can be cancelled even if the auction results have been 
published. 
An auction which has been cancelled cannot be restored.  
A cancelled auction can no longer be modified by system operators. 
All gates of a cancelled auction are suspended. 
This is a final state. 

 

 

 To access the Auction Display screen: 

• Go to Auction menu 

N.B.: Auctions cannot be modified by market participants. 
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Figure 25 Auction Display Screen 

 
 

Participants can filter the auctions they want to display using the Filtering criteria pane. 

 To filter the listed auctions: 

• In Filtering criteria, select  

o Corridor (Multiple selections are allowed by clicking on Ctrl) 

o Auction state (Published, Pre-open, Open, Closed, Published results, 
Cancelled) (Multiple selections are allowed). At the first opening of the 
screen, the default selected values are “Pre-open” and “Open”. If the 
user changes the selected values for auction state filter, then next 
opening of the screen will use these values.  

o Horizon (Multiple selections are not allowed) 

• Click on Refresh button 

 

Auctions matching the search criteria are listed in the List pane with the following 
information: 
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Column Description 

Corridor The names of the border cross section for which the 
auction is defined.  

Horizon The type of time horizon (Yearly, Monthly, Daily, 
Intraday).  

Market period start Delivery start 

Market period stop Delivery stop 

Auction identification(1) Identification of the auction : the reference for the bids to 
be submitted  

Nb of Bids If the auction is opened or pre-opened: number of valid 
(Fully Accepted) bids already submitted by the connected 
Trader on this auction 

Current state Current state of the auction (Published, Pre-open, Open, 
Closed, Published results, Canceled) 

Bid Time Left Display the remaining time before ‘Bid submission’ gate 
closure in case the auction is marked as open or pre-
open. It is the remaining time for bidding before auction 
closure. 

Action This column contains two icons: 

• New/Edit Bids: open the Bid matrix screen in edit 

mode to declare new Bids or to modify/cancel Bids on 
the selected auction. This icon is available only if the 
auction is Pre-open or Open.  

• View Bids: open the Bid matrix screen in read-only 
mode to display Bids for the selected auction. This 
icon is available whatever the auction state. 

 

 

Figure 26 Bid Time Left and Action in Auction Screen 
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(1) Auction identification: the reference of the auction to be used when submitting a 
bid. The auction ID has a naming convention: 

 Corridor code on 5 characters (e.g., 'FR-BE') « - » 

 Horizon code on 1 character (Y for Yearly, M for Monthly, D for Daily, I for 
Intraday) « - » 

 Product label: 

o On 6 characters for IFA1, IFA2, Eleclink, BritNed and Nemo Link interconnectors 
(e.g. Base product = "BASE--", On peak product = "PEAK--", Off peak product = 
"OFFPK-", daily product = “DAILY-”, shadow product = “SHADOW”, intraday 
product = “ID0024” or “ID1424” or “ID1624”) 

o On 10 characters for all other allocation corridors (e.g. Base product = "BASE------
", On peak product = "PEAK------", Off peak product = "OFFPEAK---", daily 
product = “DAILYPRODU”, shadow product = “SHADOW----”, intraday product = 
“HOURLY0024” or “HOURLY1624”) 

 Start day of the delivery period of the auction on 6 digits: format is YYMMDD 
where YY is the year, MM is the month, and DD is the day of the year « - » 

 Sequence number on 2 digits (starting by 1 and incremented in case of multi-
rounds auction or auction cancellation) 

 Example: FR-BE-M-BASE------160201-01 

By default, the auction list is sorted by increasing Bid time left. 

More information can be displayed on an auction once selected from the list and 
scrolling down to the Details pane. 

 

 When selecting an auction in List pane, Details pane is updated automatically 

To improve readability, detailed information is organized in tabs. 

 

The various tabs displayed are described below. 

 

4.3.1 Auction identification 

The “Auction identification” tab provides the same information as found in the list, 
along with a timetable summarizing the life cycle of the auction. 
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 In this tab, all the identification information of the selected auction is displayed. 

 

Figure 27 Auction identification 

 

• In Auction identification part 

o Auction identification: the reference needed for all the bids 

o Corridor 

o Market Period with the start/stop date   

o Horizon (Monthly, Daily…) 

• In Auction state there is the history of all the status of the auction with the 
state creation time. The last row in the list corresponds to the current state 
of the auction. 

 

 

4.3.2 Auction Parameters 

 In this tab, all the auction parameters information of the auction selected are 
displayed. All fields are read-only. 

 

 
Figure 28 Auction Parameter 
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• In Auction Type part, the information displayed are: 

o Auction Type: Sealed 

o Allocation mechanism: Merit Order 

• In Pricing parameter’s part: 

o Price measure unit (MWh) : configured for the corridor of the 
auction 

o Pricing procedure: Uniform price 

• In Transfer parameter’s part:  

o Transfer parameter Resale allowance tells if Resale is allowed 
from yearly auction to monthly auction. 

o Transfer parameter Transfer allowance tells if Transfer is allowed. 
It can only be done on yearly and monthly auctions. 

o Transfer parameter Resale rule tells if unused LT capacity is resold 
to daily auction (UIOSI principle) 

• In Capacity percentages (ATC percentage = 100%) 

• In Credit limit parameter’s part:  

o Credit limit checking parameter tells if financial guarantees are 
checked for the given auction.  

o Bid rejection at bidding time tells if bids can be rejected due to 
lack of credit limit. 

o Period to be secured 

o X/N rule parameter is applied for long-term auction products with 
more than one month  

4.3.3 Bidding  Parameters  

 In this tab, all the bidding parameters information of the auction selected are 
displayed. All fields are read-only. 

 

Figure 29 Bidding Parameter 
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• Define Bids & blocks: 

o Maximum number of bids the connected participant can submit 
for each corridor of the auction 

o Checked if Coupled bids are allowed 

• Define Bid quantity 

o Maximum participant rate: 100% 

o Maximum quantity: MW 

o Bid quantity increment (the bid quantity must be a multiple of this 
quantity) 

• Define Bid price 

o Currency: Euro 

o Bid price increment. Bid price must be a multiple of this value. 

 

4.3.4 Auction Gates  

In e-terraMarket ENTSO-E Capacity Auction, some processes are triggered at 
the opening or the closure of auction gates such as auction publication, auction 
clearing or auction results processing.  

 In this tab, all information about the various gates, linked to the selected 
auction, are displayed. All fields are read-only. 
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Figure 30 Auction Gate 
 

The Gate list is displayed with the following information: 

Column Description 

Name Gate name 

Opened Yes / No 

Open time Open date 
Format is “DD-MM-YYYY hh:mm”, local time. 

Closed Yes / No  

Closure time Closure date 
Format is “DD-MM-YYYY hh:mm”, local time. 

 

 

4.3.5 Products  

 In this tab, all the Products information of the selected auction are displayed. 
All fields are read-only. 
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Figure 31 Products 
 

4.3.6 Allocation Constraints 

 This tab display information of the ATC released capacity and Offered 
Capacity. 

 

 

 Figure 32 The allocation Constraints tab 

 

The allocation constraints tab displays the following information: 
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Column Description 

Technical Profile Name The related Corridor of the auction (e.g., FR-CH) 

Product identification The related product (e.g., BASE, Peak, Off-peak…) 

Product name 
The product name (e.g., Every day 00:00-24:00, On peak, Off 
peak…) 

Offered Capacity (MW) The offered capacity  

Released Capacity The resold capacity 

ATC (MW) The available capacity 

 

4.3.7 Auction Results  

 Auction results tab must be visible only when auction results have been 
published: the current state of the auction must be “Published results”. 

This tab displays the main auction results of the current auction. So, one row in 
the list corresponds to a product. Only products corresponding to the current 
auction are displayed. 

 
Figure 33 Auction Results  

 

 The Auction results list is displayed with the following information: 

Column Description 

Allocation Border Allocation Border on which capacity was offered 

Product identification Identification 

Product Name Name of the product 

Offered Capacity (MW) Offered Capacity (is expressed in MW). 

Requested capacity (MW) Requested Capacity (is expressed in MW). Sum of the bids 
(total demand) 

Allocated capacity (MW) Allocated capacity (is expressed in MW). Total allocated 
capacity for all participants. 

Auction price (EUR/MWh)  Marginal price (is expressed in EUR/MWh):  
Equals to zero if demand is lowest than the offered capacity. 
Otherwise equals to the price of the last awarded bid. 
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4.3.1 Maintenance Periods  

 Maintenance Periods tab displays the list of the reduction periods of the 
selected auction. 

 

 

Figure 34 Reduction Periods 

 

  

The Reduction Periods list is displayed with the following information: 

Column Description 

Start Start date and time of the reduction period 

Stop Stop date and time of the reduction period 

Offered capacity (MW) Reduced Offered Capacity over the given reduction period (is 
expressed in MW). 

Released capacity (MW) Equals to zero if no resale was performed. 
Equals to zero if the selected auction is not a monthly auction. 
Sum of capacity resold from yearly capacity rights to the 
selected monthly auction 

ATC (MW)  Declared reduced ATC over the given maintenance period (is 
expressed in MW). 

Comment Comment concerning the related maintenance period  

   
  

4.3.2 Comments 
 

A comment can be added by the system operator and viewed by the participant 

 
Figure 35 Comments 
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4.4 BID MANAGEMENT 

E-terraMarket ENTSO-E Capacity Auction provides the participant to display all bids 
whose bidder party corresponds to the party represented by the connected user.  
 
The submission of bids to the ECAT system by Market Participants can be done in 
two ways: 

• Entering the bids through the web interface on the “New/Edit Bids” screen.  

• Uploading a Bid document compliant with the ECAN specification, version 
4r0. In this case an acknowledgment is sent back to the Capacity Trader.  

 

4.4.1 Bid states  

 
The life cycle of a bid is controlled by a set of states as described in the UML activity 
diagram below: 

 

CreatedCreation

Fully 

accepted

Partially 

accepted

Fully 

selected
Partially 

selected

Fully 

rejected

Cancelled

Unselected

Modification

Cancellation

Modification

Successful validation

Partially successful validation

Unsuccessful validation

Modification

Cancellation

 
Figure 36: Bid state diagram  
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The bid states are described below: 
 

State name Description 

Created This is the initial state of a bid.  
This is a temporary state; this state is valid only during bid 
submission. At the end of the submission, bids are validated 
automatically by the Bid upload process, and they get into 
‘Full accepted’, ‘Partially accepted’ or ‘Rejected’ state. 

Fully accepted A bid which has passed all the validation checks without any 
error: all time intervals (bid blocks) have been fully accepted. 
If a new version of this bid is submitted (modification), then 
the modified bid must pass the validation checks again, so 
the bid must get into ‘Created state’ again. 
If the bid is cancelled, then the bid gets into ‘Cancelled’ state. 

Partially accepted A bid which has passed the validation checks with some 
errors on specific bid blocks: some bid blocks have been 
accepted whereas some bid blocks have been rejected. 

If a new version of this bid is submitted, then the modified bid 
must pass the validation checks again, so the bid must get 
into ‘Created state’ again. 
If the bid is cancelled, then the bid gets into ‘Cancelled’ state.  

Fully rejected If a bid is submitted for the first time and if this bid is fully 
rejected, then such a bid will never be created in the system.   
If a new version of a valid Bid (fully accepted or partially 
accepted) is submitted, and if this new version is fully 
rejected by the validation checks, then this Bid shall move in 
‘Fully rejected’ state. Such a bid can be resubmitted in a new 
version and pass the validation checks again; in this case the 
bid must get into ‘Created state’ again.  

Cancelled Fully accepted bids or partially accepted bids can be 
cancelled during the ‘Bid submission’ gate of the auction. 
This is a final state. 

Fully selected During the allocation of capacity (clearing phase), if all the 
bid blocks are fully selected by the allocation algorithm (all 
the requested capacity is fully selected), then the bid moves 
into a ‘Fully selected’ state. 
This is a final state. 

Partially selected During the allocation of capacity, if only a part (but not all) of 
the requested capacity is selected by the allocation algorithm 
(not all the requested capacity is selected), then the bid 
moves into a ‘Partially selected’ state.  
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This is a final state. 

Unselected During the allocation of capacity, if for all the bid blocks no 
quantity is selected then the bid moves into an ‘Unselected’ 
state. This is a final state. 

 
 
 

4.4.2 Bid Submission checks  

 
To be integrated by the eCAT system, bids must abide by the following rules: 
 

• Bids must be received before closure of the ‘Bid submission’ gate. 

• Participants must own an entitlement for the directed border and for the 
horizon of the auction. 

• A Bid document should contain all the Bids on one single auction.  

• If other users from the same company previously placed bids on corridors 
for which the user doesn’t have entitlements, the bid placed earlier should 
be present and unchanged in the submitted bid document (no 
creation/modification/deletion of bids for corridors without entitlements) 

• For a given corridor on an auction, participants cannot bid for more than 
the offered capacity.  

• For a given auction, participants cannot bid for more than the maximum 
participant rate which is a percentage of the offered capacity whose 
default value is defined in the bidding parameters of the auction and thus 
declared in the auction specification 

• The number of Bids for each corridor of a defined auction must be lower 
than the Maximum number of Bids declared in the auction specification.  

• Bid price must be a multiple of the Bid Price Increment if any was defined 
in the auction specification 

• Bid price must be equal or higher than the reserved price of the auction 

• Bid quantity must be a multiple of the Bid Quantity Increment if any was 
defined in the auction specification 

• The Bid currency must be Euro.  

• The unit of measurement for Bid price must be MWH 

• Credit limit must be higher than total bid price, when Credit Limit checking 
parameter is enabled for the given auction (*) 

• The bid certificate for the bid signature must be the correct one 
 

During the Pre-Bidding gate, capacity traders may submit bids (pre-bids) but 
some checks will not be performed until the bidding gate opens: 

• Sum of bid quantities are not checked against Offered capacity as ATC 
may still change during the pre-bidding phase 

• Financial guarantees are not checked (*) 
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When the Bid Submission gate opens, above checks are performed on pre-bids 
along with all other checks already performed when they were submitted. Pre-
bids will be rejected if they fail those validations. 

 

(*) See next section on credit limit checking 
 

4.4.3 Credit Limit checking 

“Bank guarantees” – Registered Participant can provide JAO with a collateral in 
form of the bank guarantee. Bank Guarantees must be manually registered in the 
Auction system by JAO. 

“Deposits” - The capacity auction system gets periodic reporting from the Bank 
about the balance account (BA) of Trader’s business account. 

“Potential Liabilities” of a trader are determined as the sum of values of bids 
(based on the bid price) already submitted: 

- On monthly auctions whose clearing gate is not opened yet 

- On yearly auctions whose clearing gate is not opened yet 

o  in this case liabilities may be set as 2/12 of the values of bids (based on 
the Bid price) already submitted. This happens only when there is no 
possibility to invoice potential capacities in advance (otherwise 1/12 is 
used). 

 

“Actual Liabilities” of a trader are determined as the sum of values of bids fully or 
partially selected (based on the Auction price) already submitted: 

- On monthly auctions whose Auction evaluation gate is closed 

- On yearly auctions on yearly auctions whose Auction evaluation gate is closed 

o  in this case liabilities may be set as 2/12 of the values of bids (based on 
the Auction price) already submitted. This happens only when there is 
no possibility to invoice potential capacities in advance (otherwise 1/12 
is used). 

 

“Credit Limit” is available amount of money that can be used by the trader for 
future bidding. Credit Limit is calculated as: 

 

Credit Limit = Bank Guarantees + Deposits – Actual Liabilities 
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Some auctions may allow conditional acceptance of bids even when Credit Limit is 
not sufficient (liabilities of newly submitted bids are higher than Credit Limit). In 
such cases a warning with missing amount of money is issued in the 
acknowledgement file upon receipt of those new bids. The trader has an option to 
update value of bids, increase Deposits on bank account or increase Bank 
guarantees. If no action is done and Credit Limit is still not sufficient at the end of 
Bidding period (before the clearing is run) bids are rejected one by one starting 
with the one having the lowest price until Credit Limit is sufficient.  

 

4.4.4 New Bid Creation through UI  

 
When bids are directly entered through the web page, the system carries out all 
necessary data validation. 

Through the auction screen, participants can submit new bids for a selected auction. 
To do this, in Auction screen, the User must select an auction in Auction list and then 
click on ‘New/Edit Bids’ button in column Action.  

Users can also create new bids through submenu ‘New/Edit bids’ in Bid menu. 

 

 

Figure 37 New/Edit Bids submenu 
 

The “New/Edit Bids” screen displays all the bids for a given auction on the same screen, 
as a matrix. 

In this way, the User can submit several Bids to a given auction at the same time and in 
a single step. 

The presentation differs according to the horizon of the auction: 

• Intraday/Daily auctions: bids are displayed in columns and products are displayed in 
rows by corridor 

• Long-Term auctions: bids are displayed in rows and the corridor is displayed in 
column. 
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Figure 38 Bid Creation on a CEE LT Auction 

 

 

 
Figure 39 Bid Creation on IF1-FR-GB Intraday Auction 
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 To create a new bid 

When the new bid is requested from the auction screen, the auction parameters and the 
auction ID are automatically displayed. 

• The first set of fields available in the screen act as filters to narrow the list 
of selectable auctions. 

o Select a Corridor 

o Select a Horizon  

o Select a Market Period (Auction delivery period) 

✓ For Daily Horizon: select a Day in DD-MM-YYYY format, for 
example: 24-04-2023 

✓ For Monthly Horizon: select a Year (for example: 2023) and 
a Month (for example: May) 

✓ For Yearly Horizon: select a Year (for example: 2023) 

o Choose Auction identification among the drop-down list.  

The listed auctions are all auctions defined for the selected horizon, 
market period and corridor, with a ‘Pre-Open’ or ‘Open’ status. 

• Credit Limit are summarized in the top section of the screen 

 

• In the Bid list part, the system displays a Bid matrix: 
 

✓ Daily Auctions: One empty Bid is displayed with 1 column for Bid Qty 
and 1 column for Bid Price. The products sold on the selected auction 
are displayed in rows. The system displays also the Offered capacity, 
the total bided quantity per hour, and the total Offered capacity over all 
the hours. To add a new bid, click on the “+” button situated in the 
upper right corner, next to the bid identification. The user will be 
notified when he has reached the limit of bids. 
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Figure 40: Add new intraday bid    

 
✓ LT Auctions: N empty Bids are displayed in rows with 1 column for Bid 

Price and 1 column for Bid Qty where N is the maximum number of 
Bids. The system displays also the Offered capacity and the total bided 
quantity.  

 

The participant must enter Bid quantity and Bid Price for each product sold 
on the selected auction. Besides, the Participant may enter several Bids at 
the same time through this Bid Matrix screen. 

For daily auction, there will be 24 hourly products to specify. If no bid is to 
be declared on a given hour, leave a 0 for both quantity and price. 

 

The system automatically generates the corresponding ECAN Bid file and 
internally uploads it into the system. 

• A page is displayed allowing submitting participants to follow the current 
processing (same as for any file upload), and its result. 
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Figure 41 New Bid: Status of the creation. 
 
 

That bid submission follow-up page also includes the following button:  

o  “New/Edit Bids”: Pressing that button brings up the New/Edit Bids 
creation screen with the same Horizon, Market Period, Corridor and 
Auction ID filters as in the previous display. 

 

  

 To view a new bid document: 

• Once the process is complete, go to File -> Download 

o Select Bid as document type 

o Enter the start/stop date corresponding to the time the bid was 
created (registration time checked) or the start/stop date 
corresponding to the market period of the associated auction 
(Market period checked).     

o The document list displays the bid document submitted to the 
system.  
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Figure 42 View list Bid document. 

 

• Select your new bid document. 

• Click on open icon in Action column. The XML will be displayed in a 
viewer. 

 
Figure 43 View the Bid document. 

 

 To download a new bid document: 

• Select your new bid document. 

• Click on save icon in Action column 
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 To see the new bid document acknowledgment: 

• Select your new bid document. 

• Click on open icon in Acknowledgement column. The XML will be 
displayed in a viewer. 

 

 

Figure 44 New Bid: View acknowledgement of new Bid document. 

 

4.4.5 New Bid creation through File Upload  

The procedure to upload a bid file into the capacity auction system is the generic 
procedure to upload a file into the capacity auction system. It is done from the File 
Upload screen.  

The parsing follow-up and the review of acknowledgement can be done with File 
Download screen. Please refer to preliminary sections to get the detailed 
instructions on how to upload a file, check the acknowledgement status and review 
the details of acknowledgement. 

For a given auction, all the Bids must be submitted within the same ECAN Bid 
document.  

If the Trader wants to modify or cancel one or several Bid(s) for this given auction, 
he will have to submit a new ECAN Bid document with the same document ID and 
an incremented document version.  

 

4.4.6 Copy/paste from Excel 

The system offers the possibility to copy Bids from an Excel sheet and paste them to 
the “New/Edit Bids” screen. 
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  To copy/paste Bids from Excel: 

• Enter the “New/Edit Bids” screen (from Auction screen or Bid screen) 

• Download the Excel template for the bids and create the bids 

• In the Excel sheet, select the data grid content to be copied. 

• Copy the selected content to the clipboard (Press CTRL-C on the 
keyboard or make a right click and select Copy in the contextual menu) 

• Go back to the “New/Edit Bids” screen and Press CTRL-V to paste the 
selected content from the clipboard.   

Note that the System performs some basic validation checks: 

• LT auctions: 

✓ Rows number should be equal or less than the maximal number of Bids 

✓ Columns number should be a multiple of 2 

✓ The header of the bid must be the corridor for which the bids are created 
and will occupy 2 columns, corresponding to the quantity and the price 

✓ Quantity and Price must be numbers 

✓ If the Price contains decimals the separator must be “.”  

• Daily auctions: 

✓ Rows number should be equal to the number of hours within the delivery 
day of the auction (23, 24 or 25) 

✓ Columns number should be a multiple of 2 

✓ Columns number should be equal or less than the 2*N where N is the 
maximal number of Bids 

✓ The header of the bid must be the corridor for which the bids are created 
and will occupy 2 columns, corresponding to the quantity and the price 

✓ Quantity and Price must be numbers. 

✓ If the Price contains decimals the separator must be “.” 

 

4.4.7 View bid screen 

Through the auction screen, participants can view in the same screen in read-only 
mode all the bids that have been submitted to the selected auction.  

To do this, in Auction screen, the User must select an auction from the Auction list 
and then click on ‘View Bids’ button in column Action.  
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The “View Bids” screen displays all the bids for a given auction on the same screen in 
read-only mode, as a matrix. 

The user could also access to the “View Bids” screen through the menu Bid -->View 
Bids. 

The presentation differs according to the horizon of the auction: 

• Intraday/Daily auctions: bids are displayed in columns and products are displayed 
in rows 

• Long-Term auctions: bids are displayed in rows and products are displayed in 
columns. 

 

 

 

 
Figure 45 View bids screen of LT auctions 
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Figure 46 Daily auctions – Bid screen 

 To display the Bids in read-only mode for a given auction: 

 

When the “View Bids” screen is accessed from the auction screen, the 
filtering criteria are automatically filled. 

 

• The first set of fields available in the screen act as filters to narrow the list 
of selectable auctions. 

o Select a Corridor 

o Select a Horizon  

o Select a Market Period (Auction delivery period) 

✓ For Daily Horizon: select a Day in DD-MM-YYYY format, for 
example: 24-04-2023 

✓ For Monthly Horizon: select a Year (for example: 2023) and 
a Month (for example: May) 

✓ For Yearly Horizon: select a Year (for example: 2023) 

o Choose Auction identification among the drop-down list.  

o Select Corridor from the list of available corridors (included in the 
selected auction)  

The listed auctions are all auctions defined for the selected horizon, 
market period and corridor, with a ‘Pre-Open’ or ‘Open’ status. 
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• In the Bid list part, the system displays a Bid matrix: 
 

✓ Daily Auctions: Bids are displayed in columns with 1 column for Bid 
Price and 1 column for Bid Qty. The products sold on the selected 
auction are displayed in rows. The system displays also the Offered 
capacity, the total bided quantity per hour, the total Offered capacity 
over all the hours and the total bided quantity over all the hours.  

✓ LT Auctions: Bids are displayed in rows with 1 column for Bid Price 
and 1 column for Bid Qty. The system displays also the Offered 
capacity and the total bided quantity.  

 

4.4.8 Bid List 

With the Bid display, participants have access to all bids they have submitted. 

To display a bid list, select the Bids submenu in Bid menu, enter filtering criteria 
and press the refresh button. 

 

 

Figure 47 Bid list display 

After displaying the Bid Management view, the displayed bids can be filtered using 
a set of Filter properties. 

 To filter the bids to be displayed: 

• In Filtering criteria select   

o Corridor (Multiple selections are allowed) 
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o Bid state (Created, Fully accepted, Partially accepted, Fully 
rejected, Cancelled, Fully selected, Partially selected, Unselected) 
(Multiple selections are allowed) 

o Version (Multiple selections are allowed) 

o Horizon (Multiple selections are not allowed) 

• Click on Refresh button 

A row in the list represents one bid. 

 

The result of the bid filtering is displayed in the table with the following information: 

Column Description 

Bid Identification The identification assigned by the sender that uniquely 
identifies the bid. 

Version 1 Version of the bid.  All the versions of a bid can be displayed, 
but only the latest version of a bid is considered in the process 
of auction clearing 

Corridor The name of the oriented border corridor for which the auction 
is defined.  

TSO Border TSO Border 

Auction 
identification 

Unique identification of the auction to which the bid is 
addressed 

Divisible An indication whether each element of the bid may be partially 
accepted or not. A yes indicates it can be partially accepted. 

By default, this parameter is set to Yes. 

Product Product associated to a selected auction and one bid block  

Qty (MW) Bid Quantity 

Price  Bid Price 

Price measure unit  Price measure unit (EUR/MWh) 

Current state Current state of the selected bid 

 
1 N.B.: A new version of a bid is created if the operator performs a modification of an existing bid. A new 
row appears in the Bid table if the filtering criteria specify the selection of all versions of bids. 
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Column Description 

Action Open: Edit the selected Bid document in an XML viewer.  

The XML Bid document corresponds to the version of the 
document for the selected Bid identification. 

Save: Download the selected document in its original format in 
a local directory 

 

Users can select a bid in the list. The screen provides detailed information about 
the selected bid if any. 

 

 To see the details of a bid: 

• Select the bid 

• The detail part is automatically updated 

The various tabs displayed are described below. 

 

4.4.8.1 Bid identification 

 In this tab, all the identification information of the bid selected is displayed 
(all the fields are read-only). 

• In Bid identification part 

o Bid identification  

o Corridor 

o Market Period with the start/stop date   

o Auction identification to which the bid is addressed 

• In Version part 

o The version of the selected bid 

o If it is the last version 

o The creation time 

o The creation user 

• In Bid states there is the history of all the status of the bid with the 
state creation date and the state creation user. The last row in the list 
corresponds to the current state of the bid. 
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• In Parties  

o Bidder name: name of the submitter  

o Subject party : name of the Capacity Trader 

 

 

Figure 48 Bid identification 

 

 

4.4.8.2 Bid blocks  

 In this tab, all the bid details are displayed: quantity, price… for each 
product (All the fields are read-only).  

 

Figure 49 Bid Blocks 

 

The bid details list displays the following information: 

 

Column Description 

Product identification Identification of the product to which the bid is addressed 

Product name Name of the product 

Bid quantity Bid quantity (is expressed in MW) 
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Column Description 

Bid price Bid price (is expressed in EUR/MWh) 

Awarded quantity Awarded quantity (Is expressed in MW). 
Visible only when auction results have been published 

Awarded price Awarded price (Is expressed in EUR/MWh). 
Visible only when auction results have been published 

 

 

4.4.8.3 Bid Parameters  

 In this tab, all the bid parameter information is displayed (all the fields are 
read-only). 

 

Figure 50 Bid Parameters 
  

 

4.4.9 Bid Modification  

 
There are 3 ways to modify bids: 

• By submitting of a new version of the original Bid document with an update for 
the Bid being modified. 

 Submit the same bid document after having updated it with the relevant bid 

quantity and price and increased the document version by 1 including all bids 
already contained in the old version of the document. 

• By modification through the UI. 

 To modify a bid through the UI from Auction menu:  

• Select in List the auction associated to the bid to be modified 

o In column Action, click on New/Edit Bids button. 

o An Edit Bid screen is displayed with all the Bid information preset.  

o Change Bid quantity and/or Bid price 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

Proprietary – See Copyright Page      68 

o Note that if you click the Reset to current bid values button, then all 
your changes are cancelled, and the bid matrix is restored with the 
values of Bids currently saved in the database 

o Once all information is filled in, click on the ‘Save’ button to finish the 
creation of the new Bids and submit it to the capacity auction system. 

o A new Bid XML file is generated. 

Or 

 To modify a bid through the UI from Bid tab    ->    New/edit Bid:  

o An Edit Bid screen is displayed with all the Bid information preset.  

o Change Bid quantity and/or Bid price 

o Note that if you click the Reset to current bid values button, then all 
your changes are cancelled, and the bid matrix is restored with the 
values of Bids currently saved in the database 

o Once all information is filled in, click on the ‘Save’ button to finish the 
creation of the new Bids and submit it to the capacity auction system. 

o A new Bid XML file is generated. 

 
Figure 51 Edit Bid 

4.4.10 Bid Cancellation 

 
There are 2 ways to cancel bids: 

• By submitting a new version of the Bid document not including the Time Series 
of the Bids to be deleted. 
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 Submit the same bid document after having removed the relevant bid time 

series and incremented the document version by 1.  

• By a cancel Through the UI. 

 

 To cancel a bid through the UI:  

• Go to Auction menu 

• Select in List the auction associated to the bid to be cancelled 

o In column Action, click on New/Edit Bids button. 

o An Edit Bid screen is displayed with all the Bid information preset. 

o Click the Clear Bid button linked to the bid you want to cancel. You can 
also click the Clear All Bids button if you want to cancel all the Bids on 
the selected auction. 

o Note that if you click the Reset to current bid values button, then all 
your changes are cancelled, and the bid matrix is restored with the 
values of Bids currently saved in the database  

o Once all information is filled in, click on the ‘Save’ button to finish the 
creation of the new Bids and submit it to the capacity auction system. 

o Once the cancellation is confirmed the bid status changes to 
‘Cancelled’ and a new Bid XML file is generated. 

Note that you can also access to the Edit Bid screen by clicking on “New/Edit Bids” in 
the Bid tab.  

 

Figure 52: New/Edit Bids menu 
 

IMPORTANT NOTE: For daily auctions the New/Edit Bids button leads to 
actions on one single bid time series corresponding to 24 hours of bids: 

Consequently, to cancel a single hourly Bid via UI, participants should consider 
bringing up the Edit screen and put a 0 for quantity and price for the desired hour. 
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4.5 Default bids 

 
E-terraMarket ENTSO-E Capacity Auction provides the participant the possibility to 
define default bids. 

 
The default bids could be defined: 

• For each corridor, 

• For each horizon (Intraday, daily, monthly, yearly …), 

• For each auction type (shadow, base, peak …). 

 

4.5.1 Default Bid submission checks  

 
E-terraMarket ENTSO-E Capacity Auction provides the participant to display all 
default bids whose bidder party corresponds to the party represented by the 
connected user.  

The submission of default bids to eCat system by Market Participants can be 
done through the web interface through the “New/Edit Default bids” screen. 
 
To be integrated by the eCat system, bids must abide by the following rules: 

• Price is mandatory. 

• Quantity is mandatory. 

• Quantity and Price must be numbers. 

• Positions on all the hourly intervals are required. 

• Default bid prices must be a multiple of 0.01Eur. 

• Default bid quantities must not have decimals. 

• The Default bid currency must be Euro.  

• The unit of measurement for Default bid price must be MWH. 
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• Traders are not allowed to change default Bids while the corresponding 
auction is currently running. An explicit error message is displayed if a 
Trader tries to change default Bids while there is a lock on default bids for 
the given corridor. 

• A Trader can participate in a shadow auction only if he holds an 
entitlement on the corridor for daily auctions.  

• Credit limit is checked for shadow auction at default bidding gate closure 
(warning only), pre-bidding gate closure if it exists (warning only) and 
bidding gate closure (rejection of bids until CL is satisfied). 

 
 

4.5.2 Default Bids exceeding OC 

 

When the total bided quantity exceeds OC of the auction, Bids will be created from 
default Bids according to a priority order: 

✓ Priority order is implicitly given by the bids price: Bids with the highest price 
have the highest priority, bids with the lowest price have the lowest priority. (*) 

✓ Bids are created one by one from default Bids by following the priority order 
and until total bided quantity exceeds OC of the auction  

✓ Bid quantity of the last bid that exceeds OC is not used so that total bided 
quantity is not over the OC. 

✓ Remaining default Bids within the priority order do not lead to creation of Bids. 

 

(*) For daily auctions, the priority order is implicitly given by the bids values: Bids with 
the highest value have the highest priority, bids with the lowest value the lowest priority. 
(Bid value = sum of quantity by price for all the positions of the same bid) 

 

4.5.3 New default Bid Creation  

Users can create new default bids through submenu ‘New/Edit Default bids’ in Bid 
menu. 

 

 

Figure 53 New/Edit Default bids submenu 
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The “New/Edit Default bids” screen displays all the default bids for a given corridor on 
the same screen, as a matrix. 

In this way, the User can submit several Default bids to a given corridor at the same 
time and in a single step. 

 

 
Figure 54 Default Bid Creation screen 

 

 To create a new default bid 

• Select a Corridor 

• Select an Auction type (Intraday, Daily, Shadow, Monthly, Yearly, …) 

• In the default Bid list part, the system displays a Default Bid matrix: 

The participant must enter a Quantity and a Price for each hour of the day 
(including the missing hour and the repeated hour for clock change). 
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Besides, the Participant may enter several Default Bids at the same time 
through this Default Bid Matrix screen. 

There are 25 hourly products to specify. If no default bid is to be declared 
on a given hour, leave a 0 for both quantity and price. 

 

• Once all information is filled in, click on the ‘Save’ button to finish the 
creation of the new default Bids and submit it to the capacity auction 
system. 

• A page is displayed allowing submitting participants to follow the current 
processing, and its result. 

 

 

Figure 55: Auction Type selection on CH-DE 

 

 

Figure 56 Creation’s status of Default Bid. 
 
 

That default bid submission follow-up page also includes the following button:  
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o  “New/Edit default Bids”: Pressing that button brings up the 
New/Edit Default Bids creation screen with the same Corridor filter 
as in the previous display. 

 

4.5.4 Copy/paste from Excel 

The system offers the possibility to copy Default Bids from an Excel sheet and paste 
them to the “New/Edit Default bids” screen. 

  To copy/paste Default bids from Excel: 

• Enter the “New/Edit Default bids” screen (through “New/Edit Default bids” 
submenu) 

• Select a corridor  

• Select an Auction type 

• In the Excel sheet, select the data grid content to be copied. 

• Copy the selected content to the clipboard (Press CTRL-C on the 
keyboard or make a right click and select Copy in the contextual menu) 

• Go back to the “New/Edit Default bids” screen and Press CTRL-V to paste 
the selected content from the clipboard.   

Note that the System performs some basic validation checks: 

• Rows number should be equal to 25 

• Columns number should be a multiple of 2 

• Columns number should be equal or less than the 2*N where N is the 
maximal number of Bids 

• The header of the bid must be the corridor for which the bids are created 
and will occupy 2 columns, corresponding to the quantity and the price 

• Quantity and Price must be numbers. 

• If the Price contains decimals the separator must be “.” 

 

4.5.5 Default Bid Modification  

 

 To modify a Default bid through the UI:  

• Enter the “New/Edit Default bids” screen (through “New/Edit Default bids” 
submenu) 
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• Select a corridor  

• Select an Auction type 

o An Edit Default Bid screen is displayed with all the Default Bids that 
have been previously entered.  

o Change the Quantity and/or the Price 

o Note that if you click the Reset to current default bid values button, 
then all your changes are cancelled, and the default bid matrix is 
restored with the values of Default Bids currently saved in the 
database 

o Click the Save button. 

 
 

 
Figure 57 Edit Default Bids 

4.5.6 Default Bid Cancellation 

 

 To cancel a Default bid through the UI:  

• Enter the “New/Edit Default bids” screen (through “New/Edit Default bids” 
submenu) 

• Select a corridor  

• Select an Auction type 

o An Edit Default Bid screen is displayed with all the Default Bids that 
have been previously entered.  
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o Click the Clear Default Bid button linked to the Default bid you want to 
cancel. You can also click the Clear all Default Bids button if you want 
to cancel all the Default Bids on the selected corridor. 

o Note that if you click the Reset to current default bid values button, then 
all your changes are cancelled, and the default bid matrix is restored 
with the values of default Bids currently saved in the database  

o Click the Save button. 

 

IMPORTANT NOTE: to cancel a single hourly Default Bid via UI, participants 
should consider bringing up the Edit screen and put a 0 for quantity and price for 
the desired hour. 

 

 

4.5.7 Surrogate Default bidding 

In case Participants do not have access to the GUI, they may ask JAO operators 
to submit, modify or cancel Default bids on their behalf. As a matter of fact, JAO 
operators have an interface which grants them the ability to manually submit 
default bids and cancel default bids.  

Note that JAO operators have no interface to manually modify Default bids as they 
cannot see the price and the quantity of the default bids. Consequently, the way 
JAO operators manually modify a Default bid on behalf of Capacity traders is 
through the cancellation of the previous Default bid and the submission of a new 
Default bid with the modified characteristics. 

In their request, Participants should communicate detailed Default bid 
characteristics to JAO, so that JAO operators are able to perform manual default 
bid submission on their behalf.  

Once Participants get back their access to the GUI, they can check that the Default 
bids have been properly treated by JAO operators in the Default Bid display. 

 

 

4.6 SHADOW AUCTIONS 

Shadow auctions correspond to fallback for daily implicit (Market Coupling) and 
explicit auctions. 
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4.6.1 Business process overview 

Business process sequence is summarized as below: 

• Traders submit default Bids to eCat by giving default hourly qty/price values 
for a given oriented border. 

• Shadow auctions are visible on JAO website only when Fallback is 
triggered.  

• Shadow auctions can be easily differentiated from other auctions thanks to 
their auction ID which contain “SHADOW” substring. 

• TSOs send ATC with auction ID of a shadow auction to eCat. 

• ATC is published on JAO website only when Fallback is triggered. 

• If TSO don’t confirm the shadow auction operation to JAO, then no capacity 
is allocated on the shadow auction for the given day.  

• In the event of a shadow auction, JAO Operator activates manually the 
auction. The System automatically imports from the database the set of 
default Bids at opening of Bid submission gate and run the clearing.   

• The shadow auction is cleared by the same Merit order algorithm as for 
clearing of LT Explicit auctions. Check of credit limit is done at the end of 
bidding gate. 

• In case of NL-NO and DE-D2 border, a ramping constraint has to be taken 
into account.  

• Allocation results of the shadow auction are published on JAO website.  

• Allocation results are sent to TSOs, and Traders. 

• Programming authorizations are processed by the System and sent to 
TSOs and Market participants in the same way as in the explicit auction 
process 

• Settlement and invoicing is run in same way as in the explicit auction 
process: shadow auctions are invoiced on M+1. 

• When UIOSI of LT Capacity is settled at the marginal price, then the 
marginal price of the shadow auction is used when a shadow auction is 
triggered.  

 

4.7 ALLOCATION RESULT 

 
 The ‘Auction evaluation’ gate begins immediately after the ‘Bid submission’ gate 
closure. 
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 At the opening of ‘Auction evaluation’ gate, the System launches a clearing to 
compute the auction results. 
 
 
The allocated results process is the following: 

• Process of auction results: run of the bid selection process and determination of 
the awarded bids and the marginal price.  It is broken into following steps: 

o Bid selection process:  

▪ Execution of the clearing algorithm 

▪ Determination of the awarded bids and the auction prices 

▪ Bid state management: process of the bid selection status 

o Generation of an event log ‘Auction results have been processed’. 

The following data flow diagram shows the input data, and the output data associated to 
this bid selection process: 

 

 

For each product (auction block) that is sold on the auction, the bid selection process 
allocates the Offered capacity of this product to the market participants by determining 
following output data: 

• Awarded quantity and awarded price for each Bid Block that has been 
submitted on the given product. 

• Auction price  

• Total requested capacity: sum of Bid Block quantities 

• Total allocated capacity: part of the Offered capacity that has been sold. 

 

The system switches the state of each Bid of the system that has been submitted on the 
given auction (consider only the latest version of the Bids) in one of the following states: 

 

Requested capacity 

Auction price 

Awarded Bids 

Allocated capacity 

 

Bid selection process 
Auction 

Bids 
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Fully selected During the allocation of capacity, if all the bid blocks (time intervals) 
are fully selected by the allocation algorithm (all the requested 
capacity is fully selected), then the bid moves into a ‘Fully selected’ 
state. 
This is a final state. 

Partially 
selected 

During the allocation of capacity, if only a part (but not all) of the 
requested capacity is selected by the allocation algorithm (not all the 
requested capacity is selected), then the bid moves into a ‘Partially 
selected’ state.  
This is a final state. 

Unselected During the allocation of capacity, if for all the bid blocks no quantity is 
selected then the bid moves into an ‘Unselected’ state. 
This is a final state. 

 
It is possible that some bids are not considered by the allocation algorithm due to 
insufficient Credit Limit – see Credit Limit checking. 
 

• Publication of auction results: results are made available to the participants in 
the web interface. ECAN Allocation Result documents are generated and 
made available to the participants in the file download interface. Furthermore, 
auction results are generated and published on ENTSO-E Transparency 
Platform. 

• Allocation result display: The allocation results are displayed in the user 
interface. Allocation results correspond to the detailed results of the bid 
selection process, they provide the awarded quantity and the awarded price 
for each bid block that has been submitted on the given auction. 

 

4.7.1 Allocation Result Control 

Once the auctions results processing is ended, output data can be checked in 
several ways through the Participant UI: 

 To check auction results: 

1) In the Auction display:  

• Go to Auction menu 

• Apply the filters to see the auction. 

• In the Auction results tab, check the allocation results. 

This tab displays the main auction results for the selected product 
which had been put on sale. 
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Figure 58 Auction Screen after monthly auction clearing 
 

2) In the Bid List display:  

• Go to Bid -> Bids  

• If not selected by default, filter to see the bids. 

• In the Bid blocks tab, following fields are displayed 

o Awarded quantity 

o Awarded price 

 

Figure 59 Bid Screen after clearing 1 
 

 

• The Bid could have different states (Fully selected, partially selected, 
Unselected, Cancelled). The participants can check these states in the 
menus below: 

o Current state: The current state of the bid is displayed in the list 
of bids (column Current state) 

o Bid identification tab: all bid states are displayed in the bid state 
list   
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Figure 60 Bid List Screen after clearing 2 
 

3)  In the Allocation results menu: 

• Go to the menu Capacity right -> Allocation results  

After displayed the Allocation results Management view, the displayed 
allocation results can be filtered using a set of Filter properties. 

 To filter the allocation results: 

• In Filtering criteria, you could select 

o Corridor 

o Horizon 

o Select a Market Period (Auction delivery period) 

✓ For Daily Horizon: select a Day in DD-MM-YYYY format, for 
example: 29-04-2023 

✓ For Monthly Horizon: select a Year (for example: 2023) and 
a Month (for example: May) 

✓ For Yearly Horizon: select a Year (for example: 2023) 

o Auction identification: Select the auction identification from drop 
down list 

• Click on Refresh button 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

Proprietary – See Copyright Page      82 

 
The result of the allocation results filtering is displayed.  

The presentation differs according to the horizon of the auction: 

✓ Daily auctions: allocation results are displayed in columns and 
products are displayed in rows 

✓ Long-Term auctions: allocation results are displayed in rows and 
products are displayed in columns. 

  
 

Long-term auctions: 
 
The list presents the results on a bid-by-bid basis. 

A row in the list represents one Bid and it gives the allocation results for this Bid: 

✓ Awarded quantity (MW) 

✓ Clearing price (EUR/MWH) 

✓ Bid quantity (MW) 

✓ Bid price (EUR/MWH)  
 
Total awarded quantity (MW) and total bided quantity (MW) are displayed in the 
first row, just under the headers.  

  
Figure 61 Allocation results of long-term auctions 
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Daily auctions: 
 
The 4 first columns of the list represent following information, for each hour of the 
day: 

✓ Hourly product (Delivery hour) 

✓ Total awarded quantity (MW), 

✓ Clearing price (EUR/MWH) 

✓ Offered capacity (MW). 

  
Figure 62 Allocation results of Daily auctions 
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The list presents the results on a bid-by-bid basis. 

A group of 3 columns in the list represents one Bid and it gives the allocation 
results for this Bid and for each hour of the day: 

✓ Bid quantity (MW) 

✓ Bid price (EUR/MWH) 

✓ Awarded quantity (MW).  
 
Total awarded quantity (MW) and average auction price (EUR/MWh) are displayed 
in the last row, as summary information. 

 

If an auction is cancelled after the result publication, the allocated capacity values are 
changed to 0 by the eCAT system. 

 

Allocation results can be exported to a convenient CSV file by clicking the Export results 
to CSV button. 

 

4.8 SECONDARY MARKET 

4.8.1 Transfer of capacity rights  

Any market participant can sell part or all their awarded capacity rights to another 
market participant. 

The transfer must be declared to the capacity auction system through a Transfer 
Notification. This operation could be done either through the file upload of a 
Transfer Notification ECAN Rights document v4r0 document or using the New 
Transfer screen in the GUI. 

If the transfer notification passes all business validation checks, then the transfer is 
recorded in the database, a positive acknowledgement is sent back to the 
transferor and the rights portfolio of the transferor is updated. 

Transfer notifications have to be manually confirmed by the Transferee within 4 
hours, but not later than Transfer deadline. If transfer is not approved within 4 
hours, then the transfer notification is automatically cancelled by the System. 
When waiting for the transfer approval, the transfer notification is pending and the 
transferor can cancel the transfer. 

As soon as a transfer notification is confirmed, the rights portfolio of the 
Beneficiary of the transfer is updated and the System sends to both transferor and 
transferee a Notification of approved transfer in the form of an ECAN Rights 
document v4r0. These notifications of approved transfer are available for 
download in the File download screen.  
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The transfer confirmation is sent by mail as an attachment to the Transferor and 
the Transferee within 30 minutes after the reception of the transfer notification.  

In case of transfer rejection, the system generates only an acknowledgement with 
a negative status and reason for rejection to the transferor. No message is sent to 
the transferee. 

Note: The financial transaction between participants for transfers of capacity rights 
is not managed by the capacity auction system.  

4.8.1.1 Transfer Notification submission rules 

To be properly integrated by the system, transfer notifications must follow some 
rules: 

• Transfer notifications including transfers on market day D must be received 
before closure of the ‘LT Transfer’ gate, that gate closing every day at a 
configurable time (depending on the domain) before the sending of LT 
programming authorizations to TSOs. 

• Transferor must be the owner of the capacity to be transferred. 

• Transferor and transferee must correspond to registered Capacity traders that 
are valid over all the transfer period. 

• Transferee must hold an entitlement for the directed border (whatever the 
horizon) on which the transfer takes place.  

• For yearly capacity, the length of the transfer should not exceed the period for 
which the money for yearly capacity has been blocked on the business bank 
account (i.e., If a Market Participant does a transfer on the 16th of March 
2023, then yearly capacity can be transferred only from 18/03/2023 to 
30/04/2023). The Market Participant can ask JAO to deactivate this rule, once 
he paid the months of the period he wants to transfer. A Transfer notification 
document should contain one transfer on one single auction. 

• Transfer period can be on one or several days. 

• The minimum resolution of the transfer is 1 MW over 1 hour. 

• There is no versioning of transfer notifications. 

• To cancel a transfer, the transferee should declare a reverse transfer.  

 

4.8.1.2 New Transfer Notification through GUI  
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Users can declare a new transfer notification through submenu ‘New transfer 
notification’ in Secondary market menu 

 
 

 
 

Figure 63 New transfer notification menu 
 

Note that if participants cannot access to the GUI, they may use the surrogate 
secondary market mode and contact JAO operators to launch downgraded mode. 

 

 To declare a new transfer notification: 

Find the auction by filtering the parameters below: 

o type: Select Transfer from drop down menu 

o corridor: Select the corridor 

o horizon: Select the horizon of the auction from the drop-down 
menu 

o transfer period start: Select the transfer period start from calendar 
icon 

o transfer period end: Select the transfer period start from calendar 
icon 

Click on Refresh button. The participant can now select the related auction.  

o Auction identification: select the auction from drop down list where 
the rights to be transferred were acquired  

o Transferee: the identification of the “transferee” party 

o Days (All days, by default): subset of days within the transfer period 
on which the transfer should be applied (All days, working days, 
Saturday and Sunday, Working days and Saturday, or Sunday) 

o Exclude maintenance periods (disabled by default): by enabling this 
checkbox, the Transferor declares that he wants to exclude 
maintenance periods with ATC=0 when processing the transfer.    
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• In the Transfer Notification schedule part, specify the quantity to be 
transferred out of the available transferable capacity for each hour of the 
day. This daily schedule will be applied for all days of the transfer period. 

o As a shortcut to quickly fill up the 24 hours of the daily schedule, 
users can specify a percentage of the available transferable capacity 
and press the “Set for whole period” button 

o To quickly fill up the schedule, set the quantity of the first hour and 
press the V button on the right side of a given hour. It will fill the 
quantity boxes to all following hours. 

 

 

Figure 64 New Transfer Notification screen 
 

The submission of the transfer notification to the explicit auction system is 
immediate as soon as the ‘Save’ button is pressed.  

4.8.1.3 New transfer notification through File Upload  

The procedure to upload a transfer notification file into the capacity auction system 
is the generic procedure to upload a file into the capacity auction system.  
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It is done from the File Upload screen. The parsing follow-up and the review of 
acknowledgement can be done with either Event log or File Download screen. 
Please refer to preliminary sections to get the detailed instructions on how to 
upload a file, check the acknowledgement status and review the details of 
acknowledgement. 

4.8.1.4 Transfer notification control 

With the Transfer Notification display, participants have access to all transfer 
notifications they have submitted or for which they are the transferee. 

To display the list of confirmed transfer notifications, select the menu Secondary 
market -> Transfer Notification List, enter filtering criteria and press the refresh 
button. 

 

 

  
Figure 65 Transfer Notification screen 

 

The filtering criteria include the corridor name, the horizon, and the transfer period 
(start and stop). 

The list of notifications determined by the filtering includes the major 
characteristics of the transfer (transferee, rights holder, auction ID, corridor, 
transfer status, transfer period, type, and Action). 

The details section provides additional information including the capacity right 
contract from which rights were ceased and the schedule of transfer over the 
transfer period.   
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 To confirm a transfer notification: 

• Select the transfer notification to be confirmed (status of this transfer should 
be UNCONFIRMED) 

• Click on the “Confirm transfer” icon in the Action column 

• The transfer is confirmed right after the click on the “Confirm transfer” icon. 

 

 To cancel a transfer notification: 

• Select the transfer notification to be cancelled (status of this transfer should 
be UNCONFIRMED) 

• Click on the “Cancel transfer” icon in the Action column 

• The transfer is cancelled right after the click on the “Cancel transfer” icon. 

 

4.8.2 Balancing service for capacity rights 

Any market participant can sell part or all their awarded capacity rights to a TSO. 

The transfer must be declared to the capacity auction system through a Balancing 
reservation. This operation can be done either through the file upload of a 
Transfer Notification ECAN Rights document v4r0 or using the New Transfer 
screen in the GUI. 

If the transfer notification passes all business validation checks, then the transfer is 
recorded in the database, a positive acknowledgement is sent back to the 
transferor and the rights portfolio of the transferor is updated. 

Balancing reservations have to be manually confirmed by the Transferee within 4 
hours, but not later than Transfer deadline. If transfer is not approved within 4 
hours, then the transfer notification is automatically cancelled by the System. 
When waiting for the transfer approval, the transfer notification is pending and the 
transferor can cancel the transfer. 

As soon as a transfer notification is confirmed, the rights portfolio of the 
Beneficiary of the transfer is updated and the System sends to both transferor and 
transferee a Notification of approved transfer in the form of an ECAN Rights 
document v4r0. These notifications of approved transfer are available for 
download in the File download screen.  

  

The transfer confirmation is sent by mail as an attachment to the Transferor and 
the Transferee within 30 minutes after the reception of the transfer notification.  
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In case of transfer rejection, the system generates only an acknowledgement with 
a negative status and reason for rejection to the transferor. No message is sent to 
the transferee. 

Note: The financial transaction between participants for balancing reservations of 
capacity rights is not managed by the capacity auction system.  

 

4.8.2.1 Balancing reservation submission rules 

To be properly integrated by the system, balancing reservations must follow some 
rules: 

• Balancing reservations for LT capacity rights must be received before closure 
of the ‘LT Transfer’ gate, that gate closing every day at a configurable time 
(depending on the domain) before the sending of LT programming 
authorizations to TSOs.  

• Balancing reservations for daily capacity rights must be received before 
closure of the ‘Daily balancing reservation’ gate, that gate closing every day 
at a configurable time (depending on the domain) before the sending of Daily 
programming authorizations to TSOs. 

• Transferor must be the owner of the capacity to be transferred. 

• Transferor must correspond to registered Interconnection Trade Responsible 
that is valid over the entire transfer period. 

• Transferee must correspond to registered System Operator that is valid over 
the entire transfer period on the specific domain corresponding to border that 
the reservation is made for. 

• Transferee must be a TSO responsible for the border that the Balancing 
reservation is made on (System Operator for the specific domain of the 
border). 

• For yearly capacity, the length of the transfer should not exceed the period for 
which the money for yearly capacity has been blocked on the business bank 
account (i.e., If a Market Participant does a transfer on the 16th of April 2023, 
then yearly capacity can be transferred only from 18/04/2023 to 30/05/2023). 
The Market Participant can ask JAO to deactivate this rule, once he paid the 
months of the period he wants to transfer.  

• A Balancing reservation document should contain one transfer on one single 
auction. 

• Transfer period can be on one or several days. 

• The minimum resolution of the transfer is 1 MW over 1 hour. 
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• There is no versioning of Balancing reservations 

• To cancel a balancing reservation, the transferee should declare a reverse 
balancing reservation or click on the “X” icon related to the balancing 
reservation from the Transfer notification screen. 

 

Figure 66  Balancing reservation cancellation by the transferor 
 

4.8.2.2 Balancing reservation through GUI 

Users can declare a new balancing reservation through submenu ‘New transfer 
notification’ in Secondary market menu 

 
 

 
 

Figure 67 New transfer notification menu option 
 

Note that if participants cannot access to the GUI, they may use the surrogate 
secondary market mode and contact JAO operators to launch downgraded mode. 

 

 To declare a new balancing reservation: 

Find the auction by filtering the parameters below: 
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o type: Select Transfer from drop down menu 

o corridor: Select the corridor 

o horizon: Select the horizon of the auction from the drop-down 
menu 

o transfer period start: Select the transfer period start from calendar 
icon 

o transfer period end: Select the transfer period start from calendar 
icon 

Click on Refresh button. The participant can now select the related auction.  

o Auction identification: select the auction from drop down list where 
the rights to be transferred were acquired  

o Transferee: the identification of the “transferee” party 

o Days (All days, by default): subset of days within the transfer period 
on which the transfer should be applied (All days, working days, 
Saturday and Sunday, Working days and Saturday, or Sunday) 

o Exclude maintenance periods (disabled by default): by enabling this 
checkbox, the Transferor declares that he wants to exclude 
maintenance periods with ATC=0 when processing the transfer.    

• In the Transfer Notification schedule part, specify the quantity to be 
transferred out of the available transferable capacity for each hour of the 
day. This daily schedule will be applied for all days of the transfer period. 

o As a shortcut to quickly fill up the 24 hours of the daily schedule, 
users can specify a percentage of the available transferable capacity 
and press the “Set for whole period” button 

o To quickly fill up the schedule, set the quantity of the first hour and 
press the V button on the right side of a given hour. It will fill the 
quantity boxes to all following hours. 
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Figure 68 New Transfer Notification screen 
 

The submission of the balancing reservations to the explicit auction system is 
immediate as soon as the ‘Save’ button is pressed.  

 

4.8.2.3 Balancing reservation through File Upload 

The procedure to upload a balancing reservation file into the capacity auction 
system is the generic procedure to upload a file into the capacity auction system. It 
is done from the File Upload screen. The parsing follow-up and the review of 
acknowledgement can be done with either Event log or File Download screen. 
Please refer to preliminary sections to get the detailed instructions on how to 
upload a file, check the acknowledgement status and review the details of 
acknowledgement. 
 
The file format for the balancing reservations is the same as for transfer 
notifications. 

 

4.8.2.4 Balancing reservation control 

With the Transfer Notification display, participants have access to all balancing 
reservations they have submitted. 

Information note: 
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The TSOs have access to the web application but with limitations. 

 

To display the list of transfer notifications, go the menu Secondary market -> 
‘Transfer Notification List’, enter filtering criteria and press the refresh button. 

 

 

  
 

Figure 69 Transfer Notification screen 
 

The filtering criteria include the corridor name, the horizon, the transferee and the 
rights holder one of them being the connected participant and a period intersecting 
the searched transfer period. 

The list of notifications determined by the filtering includes the major 
characteristics of the transfer: transferee, rights holder, auction where original 
rights were acquired, corridor, transfer status, transfer period and access to the 
transfer notification file. 

The details section provides additional information including the capacity right 
contract from which rights were ceased and the daily schedule of transfer over the 
transfer period.   
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 To confirm a balancing reservation: 

• The TSO select the balancing reservation to be confirmed (status of this 
transfer should be UNCONFIRMED) 

• Click on the “Confirm” icon in the Action column 

• The balancing reservation is confirmed right after the click on the “Confirm” 
icon. 

 

 To cancel a balancing reservation : 

• Select the balancing reservation to be cancelled (status of this transfer 
should be UNCONFIRMED) 

• Click on the “Cancel” icon in the Action column 

• The balancing reservation is cancelled right after the click on the “Cancel” 
icon. 

  

Figure 70 Cancel/Confirm Balancing reservation by the TSO 
 

4.8.3 Resale of capacity rights  

 
Resale is managed by the capacity auction system as a financial transaction. 
There is a compensation of the resold capacity.  
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The resale must be declared to the capacity auction system through a Resale 
Notification. This operation can be done either through the file upload of a Resale 
Notification ECAN Rights document v4r0 document or using the New Resale 
screen in the GUI. 

The update of the right portfolio is made as soon as the resale request has been 
accepted.  

In case of resale rejection, the system only generates an acknowledgement with a 
negative status and reason for rejection. 

 

4.8.3.1 Resale Notification submission rules 

To be properly integrated by the system, resale notifications must follow some 
rules: 

• Resale notifications must be received during the LT Resale gate of the target 
auction: this usually takes place after auction creation and before bid 
submission 

• Reseller must be the owner of the capacity to be resold 

• Reseller must be a registered Capacity trader 

• The source auction product must be the same auction product as the target 
auction product, i.e. Yearly Base can only be sold to Monthly Base, and 
Yearly Peak can only be sold to Monthly Peak.   

• A Resale notification document should contain one resale from one single 
auction to one single shorter-term auction   

• Released capacity is a constant volume if the shorter-term auction is a 
monthly auction 

• Resale period is the delivery period of the target auction (one month if the 
target auction is a monthly auction; one day if the target auction is a daily 
auction) 

• Yearly capacity can be resold only to the next monthly auctions, taking into 
consideration the resale deadline of 5 working days (therefore on the 16th of 
April 2023 a Market Participant can do a resale to Monthly auctions of May 
2016, but he can’t do a resale to Monthly auctions of June 2023). The Market 
Participant can ask JAO to deactivate this rule, once he paid the whole 
remaining due amount for the yealy capacity. 

• The amount of released capacity must be less than the minimum available 
capacity considering all hours of the resale period    

• To modify resale notifications, higher version of those resale notifications with 
same document identification should be issued 
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• To cancel a resale, you should declare a higher version of resale notification 
with an amount of resale equal to 0  

4.8.3.2 New Resale Notification through GUI  

 
Users can declare a new resale notification through the menu Secondary market 
-> ‘New resale notification’  

 
 

  
 

Figure 71 New resale Notification menu option 
 

 To declare a new resale notification: 

✓ Resale notification General Parameters: 

Find the auction by filtering the parameters below 

• Corridor: Select the corridor from drop down list 

• Source horizon: Select the LT source horizon (Yearly, seasonally...) 

• Target horizon: Select the target horizon (Quarterly, Monthly…) 

• Resale period: Select the Year and Month if the target horizon is Monthly 

Click on Refresh button. The participant can now select the auctions (source and 
target). 

✓ Capacity Right identification  

• Source Auction identification: Select the source auction where the rights 
were acquired from the drop-down list 

• Target Auction identification: Select the target auction where rights will be 
released from the drop-down list.   

✓ Resale Notification schedule 

• Specify the quantity to be released out of the available releasable capacity 
for each hour of the resale period.  
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o As a shortcut to determine the released capacity, users can specify a 
percentage of the available releasable capacity and press the “Set 
for whole period” button 

 
 

  
Figure 72 New Resale Notification screen 

 

The submission of the resale notification to the explicit auction system is 
immediate as soon as the ‘Save’ button is pressed.  

 

4.8.3.3 New resale notification through File Upload  

The procedure to upload a resale notification file into the capacity auction system 
is the generic procedure to upload a file into the capacity auction system.  

It is done from the File Upload screen. The parsing follow-up and the review of 
acknowledgement can be done with the File Download screen.  

Please refer to preliminary sections to get the detailed instructions on how to 
upload a file, check the acknowledgement status and review the details of 
acknowledgement. 

 

4.8.3.4 Resale notification control 

With the Resale Notification display, participants have access to all resale 
notifications they have submitted. 
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To display the list of confirmed resales notification, select the menu Secondary 
market -> ‘Resale Notification List’, enter filtering criteria and press the refresh 
button. 

 

 

 
 

Figure 73 Resale Notification list screen 
 

The filtering criteria include the corridor name, the horizon of the original auction 
(yearly, seasonally, quarterly or monthly), the horizon of the target auction 
(seasonally, quarterly, monthly) and a period intersecting the searched resale 
period. 
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The list of notifications determined by the filtering includes the major 
characteristics of the resale: resale, identification, version number, corridor, source 
auction where original rights were acquired, target auction where rights are 
released, resale status, resale period and actions (open, download, or modify 
resale). 

The Resale Identification tab of the details section provides additional information 
including the capacity right contract from which rights were released, the version of 
resale notification, a detailed description of the target auction. 

 

Figure 74 Resale identification tab in Resale Notification screen 

 

 

The Resale blocks tab of the details section gives the amount of released quantity 
from the yearly, seasonally, quarterly auction to the seasonally, quarterly, monthly 
auction through the selected resale.   

 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

Proprietary – See Copyright Page      101 

 
 

Figure 75 Resale blocks tab in Resale Notification screen 
 

4.9 CAPACITY RIGHT PORTFOLIO MANAGEMENT 

The capacity auction system maintains portfolios of capacity rights. 
 
Capacity rights portfolios are created or updated upon 

• Publication of allocation results 

• Auction cancellation 

• Transfer 

• Resale  

• Capacity curtailment 

 

The details of transactions leading to an update of capacity right portfolios can be 
checked by participants at any time in the Capacity right list screen. 

 

4.9.1 Review details of capacity right portfolio  

Users can review the details of capacity right portfolios through submenu ‘Capacity 
right list’ in Capacity right menu 
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Figure 76 Capacity right list menu 

 

 
Figure 77 Capacity right list screen 

 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

Proprietary – See Copyright Page      103 

The filtering criteria include the corridor name and the contract type. 

The list of contracts determined by the filtering includes the major characteristics of 
the contracts: corridor, contract type, contract identification, auction identification, 
product name, and status. 

To get the details of the portfolio for a given day of the contract period, users 
should select that day in the Details section. 

For each hour of the selected day, users can see a column on the left indicating 
the current value of capacity rights, and a column on the right for each transaction 
leading to a change of capacity rights: auction, resale, auction cancellation.  Lost 
Rights appear with a minus sign. 

4.10 ITR DESIGNATION 

Capacity traders that are not Interconnection Trade Responsible (ITR) on the 
corridors where they bid must declare the parties that will play the ITR role on both 
in Area and out Area of those corridors. This is managed by the capacity auction 
system and generally set up when the capacity traders register to the system. 

The ITR designation can also be redefined per auction. 

The deadline for such ITR designation change is the gate at the end of which 
programming authorizations are issued. 

Capacity Traders have an interface in the participant UI to set the ITR designation 
for a given auction manually in the New ITR Designation screen. 

In case they do not have access to the capacity auction participant UI, they may 
request JAO operators to perform that operation on their behalf through file upload. 

 

Limitation on ITR Designation 

A new ITR designation submitted on day D before LT programming authorization 
gate applies for all the rights acquired on the target LT auction from D+2 up to the 
end of the rights period.  

Please, refer to diagrams below to understand how this limitation applies: 
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Figure 78 Applicability of ITR Designation 

 

 

4.10.1 New ITR Designation through GUI  

 
Users can declare a new ITR designation through submenu ‘New ITR Designation’ 
in the Programming Authorizations menu: 

 

 
 

Figure 79 New ITR Designation menu option 
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Figure 80 New ITR Designation screen 

 

 To declare a new ITR designation: 

• Filtering criteria: the purpose of the filtering criteria is to select the auction 
where ITR designation will be changed.  

o 1.  Select Corridor, Horizon, Delivery date start, and Delivery date 
stop (Delivery date start and Delivery date must intersect with the 
target auction) 

o 2. Press the Refresh button.  

o 3. Select the auction from the Auction Identification drop down list. 

• Default ITR parties: This is only an information and cannot be changed. It 
tells who the default ITR is. 

• Current ITR parties for this designation: This shows the current ITR 
designation of the remain auction period. The ITR of the in area and out 
area can be changed here. 

Once new ITR designation is done, press the Save button to submit the change. 

4.11 PROGRAMMING AUTHORIZATION MANAGEMENT 

LT and day-ahead Programming Authorizations are hourly data related to 
contracts associated to capacity rights. For a given trader, they correspond to the 
finalized capacity right portfolio for the target market day. 

Programming Authorizations are dealing with a single given market day. 

LT Programming Authorizations for a given market day are generated the day 
before the daily auction of that market day (in D-2, where D is the delivery day). 
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This gives time to execute the LT nomination process and let TSOs determine the 
ATC for the daily auctions. 

Every day, one file per domain is sent to each ITR party collecting all long-term 
programming authorizations related to the given domain for which they will play 
their ITR role and nominate. 

Every day, one file per domain is sent to each Capacity Trader party collecting all 
long-term programming authorizations related to this domain for which they will 
play their ITR role and nominate, and/or one file per domain containing the long-
term programming authorizations related to this domain on the capacity right 
contracts they obtained as traders if they are not ITR. 

Every day, one file per domain is sent to each ITR party collecting all daily 
programming authorizations related to this domain for which they will play their ITR 
role and nominate 

Every day, one file per domain is sent to each Capacity Trader party collecting all 
daily programming authorizations related to this domain for which they will play 
their ITR role and nominate, and/or one file per domain containing the daily 
programming authorizations related to this domain on the capacity right contracts 
they obtained as traders if they are not ITR. 

 

Details of Programming Authorizations can be seen in the Programming 
Authorizations screen  

 

Figure 81 Programming Authorizations menu 

 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

Proprietary – See Copyright Page      107 

 

Figure 82 Nominations and Programming Authorizations screen 

 

The filtering criteria include the TSO oriented corridor name, the contract type 
(yearly, seasonal, monthly, periodic, intraday, daily…) and the market day. 

The list of contracts determined by the filtering includes the major characteristics of 
the contracts on which programming authorizations have been determined: market 
day, TSO border, rights holder, Out party, In party, contract type, contract 
identification, auction identification, and Capacity type (PTR or FTR).  

Select a contract among the list to get the details of the Programming 
Authorizations for the selected day on that contract. 

 

4.12 Settlement 

4.12.1 Display invoices screen 

This screen is dedicated to the issued invoices for the parties. 

Each party can see their own invoices issued for each month. 

To access the screen the user must go to Invoices option under the Settlement 
menu. 
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Figure 83 Invoices option - Settlement 

The screen is composed of two areas: 

• Filter area 

o Invoicing period 

o Type 

o Status 

• Invoice display area 

o Invoicing month 

o Accounting document ID 

o Type 

o SAP Invoice ID 

o Amount excl. tax (EUR) 

o Status 

To display the wanted invoices, select the desired filters and click on the Refresh 
button. 
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Figure 84 Display invoices screen 

4.12.2 Updating status of invoice 

The invoices can have only one status at one time. 

The available statuses are: 

• N/A – When the invoice is generated 

• Issued – 16th working day of the month (invoiced the M-1 period) 

• Overdue 

• Paid 

To update the status of an invoice SAP files, must be submitted to the system. 

The flow of invoice status is one of the following: 

• N/A -> Issued -> Paid 

• N/A -> Issued -> Overdue 

An invoice can’t go from the state N/A to Paid or Overdue directly, they first must 
go through the status Issued. 

 

Figure 85 Paid/Overdue invoices 
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5. Online Help 

All users of the web interface have access to the online Help. 

By clicking the button Help in the main menu, a window will open the help 
documentation. 

 

Figure 86 Help button for Participants 

 

 

Figure 87 Help button for TSOs 
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Figure 88 Help screen 

 

To leave Help screen, click on the gray area around the Help screen. 



  e-terraMarket ENTSO-E Capacity Auction for JAO 

Proprietary – See Copyright Page      112 

 

Glossary 
AAC: Already Allocated Capacity is the total amount of allocated transmission 
rights, whether they are capacity or exchange programs depending on the 
allocation method. 

ATC: Available Transmission Capacity is the part of NTC that remains available, 
after each phase of the allocation procedure, for further commercial activity. ATC 
is given by the following equation: ATC = NTC- AAC. 

Bid: A bid represents a request for a given capacity at a given price made by a 
Capacity Trader and corresponds to a single time series within a Bid document. 

Capacity trader: A capacity trader is a party that acquires capacity on the 
capacity market through the Transmission Capacity allocator. The capacity in 
question may be acquired on behalf of an Interconnection Trade Responsible or 
acquired to be sold on the secondary market. 

Interconnection Trade Responsible: Is a Balance Responsible Party or 
depends on one. He is recognized by the Nomination Validator for the 
nomination of already allocated capacity. 

Market balance area: Refer to ENTSO-E Role Model definition 

Nomination Validator: They depend on one or more System Operators and 
have the responsibility of ensuring that all capacity nominated is within the 
authorized limits and confirming all valid nominations to all involved parties. They 
inform the Interconnection Trade Responsible of the maximum nominated 
capacity allowed. Depending upon market rules for a given interconnection the 
corresponding System operators may appoint one Nomination Validator 

NTC (Net Transfer Capacity) is defined as NTC = TTC – TRM and corresponds 
to the maximum exchange between two areas   compatible with security 
standards applicable in both areas and considering the technical uncertainties on 
future network conditions. 

Offered Capacity (OC): is a part of or equivalent to the ATC that will be offered 
by the Transmission Capacity Allocator to the market. Depending on Market 
Rules, the calculation of the Offered Capacity may include the consideration of 
firm exchange programs in one direction, to increase the Offered Capacity in the 
other direction. This is generally known as Netting aimed at maximizing Offered 
Capacity 

Participant: See capacity trader 

Party: See capacity trader, System Operator, Transmission Capacity Allocator. 

Rule based allocations: These cover the allocation of capacity based on a 
given algorithm such as first come, first serve or proportional to request. This is a 
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particularity for the allocation of intraday capacity when local market rules do not 
require an auction allocation. 

System Operator: Refer to ENTSO-E Role model definition 

 Transmission Capacity Allocator (TCA): Manages, on behalf of the System 
Operators, the allocation of available transmission capacity for an Allocated 
capacity area. He offers the available transmission capacity to the market 
allocates the available transmission capacity to individual Capacity Traders and 
calculates the billing amount of already allocated capacities to the Capacity 
Traders. 
 TTC: Total Transfer Capacity TTC is the maximum exchange program between 
two areas   compatible with operational security standards applicable at each 
system if future network conditions, generation and load patterns were perfectly 
known in advance 
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